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Chapter 1

Introduction to Computers

In today’s world wherever we go we are surrounded by various varieties of
computers. They enable us to send or receive data from any part of the world
with a click of a mouse. Today we can write e-mails, play games, watch
television, listen to music, work on our office data, watch video lectures and do
endless things through our computers. Computers today come in many shapes
and sizes like desktop, laptop, palmtods, PDAs etc.

What Is a Computer

A computer is a device that accepts information (in the form of digitalized data)
and manipulates it for some result based on a program or sequence of
instructions on how the data is to be processed. A programmer is a person who
inputs the data into the computer in order to get a desired final result.

Basic Applications of a Computer

Computers have become an important part of our lives. You can use computer to
get information about the reservation of tickets (railways, airplanes and cinema
halls), books in a library, medical history of a person, a place in a map, or the
dictionary meaning of a word. The information may be presented to you in the
form of text, images, video clips, etc.

e Education Computers are extensively used, as a tool and as an aid,
for imparting education. Educators use computers to prepare notes
and presentations of their lectures. Computers are used to develop
computer-based training packages, to provide distance education
using the e-learning software, and to conduct online examinations.
Researchers use computers to get easy access to conference and
journal details and to get global access to the research material.

o Entertainment Computers have had a major impact on the
entertainment industry. The user can download and view movies,
play games, chat, book tickets for cinema halls, use multimedia for
making movies, incorporate visual and sound effects using
computers, etc. The users can also listen to music, download and
share music, create music using computers, etc.
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Sports A computer can be used to watch a game, view the scores,
improve the game, play games (like chess, etc.) and create games.
They are also used for the purposes of training players.

Advertising Computer is a powerful advertising media.
Advertisement can be displayed on different websites, electronic-
mails can be sent and reviews of a product by different customers can
be posted. Computers are also used to create an advertisement using
the visual and the sound effects. For the advertisers, computer is a
medium via which the advertisements can be viewed globally. Web
advertising has become a significant factor in the marketing plans of
almost all companies. In fact, the business model of Google is mainly
dependent on web advertising for generating revenues.

Medicine Medical researchers and practitioners use computers to
access information about the advances in medical research or to take
opinion of doctors globally. The medical history of patients is stored
in the computers. Computers are also an integral part of various kinds
of sophisticated medical equipments like ultrasound machine, CAT
scan machine, MRI scan machine, etc. Computers also provide
assistance to the medical surgeons during critical surgery operations
like laparoscopic operations, etc.

Science and Engineering Scientists and engineers use computers for
performing complex scientific calculations, for designing and making
drawings (CAD/CAM applications) and also for simulating and
testing the designs. Computers are used for storing the complex data,
performing complex calculations and for visualizing 3-dimensional
objects. Complex scientific applications like the launch of the
rockets, space exploration, etc., are not possible without the
computers.

Government The government uses computers to manage its own
operations and also for e-governance. The websites of the different
government departments provide information to the users. Computers
are used for the filing of income tax return, paying taxes, online
submission of water and electricity bills, for the access of land record
details, etc. The police department uses computers to search for
criminals using fingerprint matching, etc.

Home Computers have now become an integral part of home
equipment. At home, people use computers to play games, to



maintain the home accounts, for communicating with friends and
relatives via Internet, for paying bills, for education and learning, etc.
Microprocessors are embedded in house hold utilities like, washing
machines, TVs, food processors, home theatres, security devices, etc.

Components of a Computer System A computer is a system of many parts
working together. The physical parts, which you can see and touch, are
collectively called hardware. (Software, on the other hand, refers to the
instructions, or programs, that tell the hardware what to do.) The illustration
below shows the most common hardware in a desktop computer system. Your
system may look a little different, but it probably has most of these parts. A
laptop computer has similar parts but combines them into a single notebook-
sized package.
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Desktop computer system Let's take a look at each of these parts.

System unit The system unit is the core of a computer system. Usually it's a
rectangular box placed on or underneath your desk. Inside this box are many
electronic components that process information. The most important of these
components is the central processing unit (CPU), or microprocessor, which
acts as the "brain" of your computer. Another component is random access
memory (RAM), which temporarily stores information that the CPU uses while
the computer is on. The information stored in RAM is erased when the computer
is turned off.

Almost every other part of your computer connects to the system unit using



cables. The cables plug into specific ports(openings), typically on the back of
the system unit. Hardware that is not part of the system unit is sometimes called
aperipheral device or device.
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(1) CD/DVD drive  (2) Floppy disk drive

System unit Storage and Computer Memory Computer memory is of two
types namely, primary and secondary.

Primary IMEeImOory :- Alternatively referred to as internal memory, main
memory, and primary memory, primary storage is a storage location that
holds memory for short periods of times while the computer running. For
example, computer RAM and cache are both examples of a primary storage
device. This storage is the fastest memory in your computer and is used to store
data while it's being used. For example, when you open a program data is moved
from the secondary storage into the primary storage.

Secondary Memory :- Secondary memory refers to storage devices, such as hard
drives and solid state drives. It may also refer to removable storage media, such
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as USB flash drives,CDs, and DVDs.

Unlike primary memory, secondary memory is not accessed directly by
the CPU. Instead, data accessed from secondary memory is first loaded
into RAM and is then sent to the processor. The RAM plays an important
intermediate role, since it provides much faster data access speeds than
secondary memory. By loading software programs and files into primary
memory, computers can process data much more quickly.

While secondary memory is much slower than primary memory, it typically
offers far greater storage capacity. For example, a computer may have a
one terabyte hard drive, but only 16gigabytes of RAM. That means the computer
has roughly 64 times more secondary memory than primary memory.
Additionally, secondary memory is non-volatile, meaning it retains its data with
or without electrical power. RAM, on the other hand, is erased when a computer
is shut down or restarted. Therefore, secondary memory is used to store
"permanent data," such as the operating system, applications, and user files.

Storage Devices

Your computer has one or more disk drives—devices that store information on a
metal or plastic disk. The disk preserves the information even when your
computer is turned off.

Hard disk drive Your computer's hard disk drive stores information on a hard
disk, a rigid platter or stack of platters with a magnetic surface. Because hard
disks can hold massive amounts of information, they usually serve as your
computer's primary means of storage, holding almost all of your programs and
files. The hard disk drive is normally located inside the system unit.

Hard disk drive CD and DVD drives

Nearly all computers today come equipped with a CD or DVD drive, usually
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located on the front of the system unit. CD drives use lasers to read (retrieve)
data from a CD, and many CD drives can also write (record) data onto CDs. If
you have a recordable disk drive, you can store copies of your files on blank
CDs. You can also use a CD drive to play music CDs on your computer.

DVD drives can do everything that CD drives can, plus read DVDs. If you have
a DVD drive, you can watch movies on your computer. Many DVD drives can
record data onto blank DVDs.

Floppy disk drive

Floppy disk drives store information on floppy disks, also
called floppies or diskettes. Compared to CDs and DVDs, floppy disks can store
only a small amount of data. They also retrieve information more slowly and are

more prone to damage. For these reasons, floppy disk drives are less popular
than they used to be, although some computers still include them.

]

Why are floppy disks "floppy"? Even though the outside is made of hard plastic,
that's just the sleeve. The disk inside is made of a thin, flexible vinyl material.

Floppy disk

Mouse

A mouse is a small device used to point to and select items on your computer
screen. Although mice come in many shapes, the typical mouse does look a bit
like an actual mouse. It's small, oblong, and connected to the system unit by a



long wire that resembles a tail. Some newer mice are wireless.

Mouse

A mouse usually has two buttons: a primary button (usually the left button) and a
secondary button. Many mice also have a wheel between the two buttons, which
allows you to scroll smoothly through screens of information.
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When you move the mouse with your hand, a pointer on your screen moves in
the same direction. (The pointer's appearance might change depending on where
it's positioned on your screen.) When you want to select an item, you point to the
item and then click (press and release) the primary button. Pointing and clicking
with your mouse is the main way to interact with your computer.

Keyboard

A keyboard is used mainly for typing text into your computer. Like the keyboard
on a typewriter, it has keys for letters and numbers, but it also has special keys:
e The function keys, found on the top row, perform different functions
depending on where they are used.

e The numeric keypad, located on the right side of most keyboards,
allows you to enter numbers quickly.

e The navigation keys, such as the arrow keys, allow you to move
your position within a document or webpage.

Keyboard You can also use your
keyboard to perform many of the same tasks you can perform with a mouse.



Monitor

A monitor displays information in visual form, using text and graphics. The
portion of the monitor that displays the information is called the screen. Like a
television screen, a computer screen can show still or moving pictures.

There are two basic types of monitors: CRT (cathode ray tube) monitors
and LCD (liquid crystal display) monitors. Both types produce sharp images, but
LCD monitors have the advantage of being much thinner and lighter. CRT
monitors, however, are generally more affordable.
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LCD monitor (left); CRT monitor (right)

Printer

A printer transfers data from a computer onto paper. You don't need a printer to
use your computer, but having one allows you to print e-mail, cards, invitations,
announcements, and other materials. Many people also like being able to print
their own photos at home.

The two main types of printers are inkjet printers and laser printers. Inkjet
printers are the most popular printers for the home. They can print in black and
white or in full color and can produce high-quality photographs when used with
special paper. Laser printers are faster and generally better able to handle heavy
use.

Inkjet printer (left); laser printer (right)



Speakers

Speakers are used to play sound. They may be built into the system unit or
connected with cables. Speakers allow you to listen to music and hear sound
effects from your computer.

Computer
speakers

Modem

To connect your computer to the Internet, you need a modem. A modem is a
device that sends and receives computer information over a telephone line or
high-speed cable. Modems are sometimes built into the system unit, but higher-
speed modems are usually separate components.

)

Modem

Computer Softwares

A computer cannot do anything on its own. It must be instructed to do a desired
to do a desired job. Hence, it is necessary to specify a sequence of instructions,
which a computer must perform to solve a problem. Software tells the computer
what to do and how to do. A computer performs different operations according
to the instruction of software. Software is developed in a computer programming



language.

Types of software

Although, the range of software available today is vast and varied, most software
can be divided into two major categories: 1. System Software,

2. Application Software

System Software:

System software is a set of one or more programs, designed to control the
operation and extend the processing capability of a computer system. In general,
a computer’s system software performs one or more of the following functions:
Supports the development of other application software.

Supports the execution of other application software.

Monitors the effective use of various hardware resources, such as CPU, memory,
peripherals, etc.

Communicates with and controls the operation of peripheral devices, such as
printer, disk, tape, etc.

Hence, system software makes the operation of a computer system more
efficient and effective.

It helps the hardware components work together, and provides support for the
development and execution of application software. The programs included in a
system software package are called system programs, and the programmers who
prepare system software are referred to as system programmers.

Some of the most commonly known types of system software are: Operating
Systems: Every computer has an operating system software, which takes care of
the effective and efficient utilization of all the hardware and software
components of the computer system.

Programming Language Translators: Programming language translators are
system software, which transform the instructions prepared by programmers in a
programming language, into a form, which can be interpreted and executed.

Communication Software: In a network environment, communications
software enables transfer of data and programs from one computer to another.

Utility Programs: Utility programs are set of programs, which help users in
system maintenance tasks, and in performing tasks of routine nature. Some of
the task commonly performed by utility programs include formatting of hard
disk or floppy disks, taking backup of files stored on hard disk, sorting of the



records stored in a file, etc.
Application Software:

Application software is a set of one or more programs, designed to solve a
specific problem, or to do a specific task. For example, application software for
payroll processing products pay slips as the major output, and application
software for processing examination results produces mark sheets as the major
along with some other statistical reports. Similarly, a program written by a
scientist to solve his/her particular research problem is also application software.
The programs included in application software package are called application
programs, and the programmers who prepare application software are referred to
as application programmers. Some of the most commonly known application
software’s are: Word-Processing Software: Word processing software enables
us to make use of a computer system for creating, editing, and viewing,
formatting, sorting, retrieving and printing documents.

Spreadsheet Software: Spreadsheet software is a numeric data analysis tool,
which allows us to create a kind of computer ledger. A manual ledger is a book
having rows and columns, which accountants use for financial transactions, and
for preparing financial statements.

Database Software: A database is a collection of related data stored and treated
as a unit for information retrieval purposes. Database software is a set of one or
more programs, which enable us to create a database, maintain it, organize its
data in desired fashion, and to selectively retrieve useful information from it.

Graphics Software: A graphics software enables us to use a computer system
for creating, editing, viewing, sorting, retrieving and printing designs, drawings,
pictures, graphs, and anything else that can be drawn in the traditional manner.

Education Software: Education software allows a computer system to be used
as teaching and learning tool. A few examples of such applications are those that
teach young children to do (a) mathematics; (b) recognize alphabets; and (c)
read whole and sentences.

Entertainment Software: Entertainment software allows a computer system to be
used as an entertainment tool. A good example of such an application is
computer video games.

Concept of Computing, Data and Information Computing is a purpose
oriented activity requiring, benefiting from computers. For example, computing
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includes designing, developing and building hardware and software systems;
processing, structuring, and managing various kinds of information; doing
scientific research on and with computers; making computer systems behave
intelligently; creating and using communications and entertainment media etc.

Data can be defined as a representation of facts, concepts or instruction in a
formalized manner which should be suitable for communication , interpretation
or processing by human or electronic machine. Data is represented with the help
of characters like alphabets (A—Z, a—z), digits (0-9) or special characters(+, —, /,
* <, >, = eto).

Information is organised or classified data so that it has some meaningful
values to the receiver. Information is the processed data on which decisions and
actions are based. For the decision to be meaningful, the processed data must
qualify for the following characteristics

Timely - Information should be available when required.
e Accuracy - Information should be accurate.
e Completeness - Information should be complete.

Applications of LE.C.T. (Information Electronics and Communication
Technologies) 1.LE.C.T. is a branch of DOEACC society, that deals with the
training of government sponsors program in computer fundamentals, operation
system, MS Office, Internet, Troubleshooting and Maintenance of PC etc.

Applications of L.LE.C.T.

1. E-governance :- In simple words e-governance refers to the use by
government agencies of information technologies (such as Wide Area
Networks, the Internet, and mobile computing) that have the ability to
transform relations with citizens, businesses, and other arms of
government. These technologies can serve a variety of different ends:
better delivery of government services to citizens, improved interactions
with business and industry, citizen empowerment through access to
information, or more efficient government management. The resulting
benefits can be less corruption, increased transparency, greater
convenience, revenue growth, and/or cost reductions.

2. Entertainment :- [.LE.C.T. has a very important role to play in
general entertainment With the creation of the Internet and faster
processors, the live general and educational entertainment has got a big
boost. Computers now have almost unlimited access to any song by any
artist. Many website services allow users to purchase individual tracks or



albums directly to their PCs. With the advancement of video card and
Internet speeds, movies and programs are just a click away.

Bringing Computer To Life :-
Connecting Keyboard to CPU

Connect the keyboard to the port on the back of the computer. When looking at
the back of the computer you'll notice two PS/2 ports next to each other. Verify
you're connecting the keyboard into the purple connection as shown in the below
pictures. If your PS/2 ports are not color coded the keyboard will be the
connection closest to the left edge of the computer (when looking at it from the
back). If the connections are vertical and not horizontal as shown below the
keyboard connection may be either depending on the case and motherboard.
Look for a small symbol next to the port to identify what one is the keyboard.

Computer PS/2 ports
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Connecting Mouse To CPU

Connect the mouse to the serial port on the back of the computer. If the computer
has serial devices currently connected to the computer and the computer has two
serial ports we recommend you use the first serial connection if you encounter
problems connecting the mouse.
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Connecting Monitor To CPU

Before you connect your monitor to your PC, you need to decide where you
want to position the monitor. Set the monitor atop your desk, generally back
away from where you sit, to accommodate room for the keyboard.

Your monitor falls into one of two categories:

. Standard monitor: A regular monitor plugs into the VGA,
or graphics adapter, jack on the back of the console, as shown in this
figure. The plug goes in only one way.

Digital monitor: If you have a digital monitor, find and use the digital jack (see
this figure).
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How To Connect Printers to Computers Printers are one of the easiest devices
to set up and configure. With some printers, you can set up your printer by
simply connecting the printer to your PC and a power supply. Other printers
require a few more steps.

1. Free the printer from its box.

Also, remove all the various pieces of tape and evil Styrofoam.

2. Connect the printer’s power cable.

Plug one end into the printer and the other into the nearest wall outlet
Or power strip.

3. Connect the printer-to-console cable.

No printer comes with this cable, so you have to buy the printer cable
separately. Get a USBcable if the printer is USB-happy. Otherwise, buy
a standard, bidirectional PC printer cable.

4. Read the printer’s instruction sheet.
See whether you need to install software before turning the printer on.

5. If you need to, install your printer’s software on your PC.
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Your printer’s instruction sheet should explain how to install this software.

6. Turn the printer on by pressing its power button.

A USB printer is instantly recognized and configured
by Windows. Life is good. Printers using the traditional printer cable,
or network printers, require more work.

7. If you have a non-USB printer, click the Add a Printer toolbar
button in the Printers window.

The Add Printer Wizard starts and you just have to follow its directions to
locate and set up your printer.

Most printers, like computers, can now be left on all the time. The printer
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automatically slips into a low-power sleep mode when it’s no longer needed.
However, if you don’t print often (at least every day), it’s perfectly fine to turn
off your printer.

Checking Power Supply of The Computer The only component that should be
attached to the power supply should be a single hard drive, the motherboard and
possibly the CPU. Using the power switch on the front of the tower, power-up
the computer. If the fan inside the power supply begins to run, the power supply
is likely functioning properly. The computer has been powered up and the power
supply has passed the first test.

Reattach each component and complete the power supply test. Plug in each
component, one by one, using the appropriate connector to determine if each
component's power connection is functioning properly.

Model Answers

Q1. What is a computer?

Ans. A computer is a device that accepts information (in the form
of digitalized data) and manipulates it for some result based on a program or
sequence of instructions on how the data is to be processed.

Q2. Which are the 4 main components of a computer system?
Ans. The main components of a computer system are :
CPU

Memory

Input Devices
Output devices

Q3. What are application software?

Ans. Application software is a set of one or more programs,
designed to solve a specific problem, or to do a specific task. For example,
application software for payroll processing products pay slips as the major
output, and application software for processing examination results
produces mark sheets as the major along with some other statistical reports.
Q4. What are System Softwares?

Ans. System software is computer software designed to operate the
computer hardware and to provide and maintain a platform for running
application software.
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Q5. What are hardware and software?

Ans: Computer hardware refers to the physical parts of a computer

and related devices. The software is the information that the computer uses

to get the job done. Software needs to be accessed before it can be used Q6.
What are the different types of system software?

Ans. The most basic types of system software are: The
computer BIOS and device firmware,.
The operating system (prominent examples being Microsoft
Windows, Mac OS X and Linux),.
Utility software.

Q7. What is LLE.C.T. and its applications?
Ans. Applications of L.E.C.T. (Information Electronics and
Communication Technologies) I.LE.C.T. is a branch of DOEACC society,
that deals with the training of government sponsors program in computer
fundamentals, operation system, MS Office, Internet, Troubleshooting and
Maintenance of PC etc.

Applications of L.LE.C.T.

1. E-governance :- In simple words e-governance refers to the use by
government agencies of information technologies (such as Wide Area
Networks, the Internet, and mobile computing) that have the ability to
transform relations with citizens, businesses, and other arms of government.
These technologies can serve a variety of different ends: better delivery of
government services to citizens, improved interactions with business and
industry, citizen empowerment through access to information, or more
efficient government management.

2. Entertainment :- [.LE.C.T. has a very important role to play in general
entertainment With the creation of the Internet and faster processors, the
live general and educational entertainment has got a big boost. Computers
now have almost unlimited access to any song by any artist.

Q8. What are the types of memory?

Ans. Primary and secondary.

Q9. What are the types of secondary memory devices?
Ans. CDs, DvDs, External Hard Discs etc.

Q10. What is a program?

Ans. A program is a set of instructions.

Q11. What are the main components of a computer?



Ans. Input, CPU and Output.
Questions for self practice

Q1. What is a computer?

Q2. What are the basic applications of a computer?

Q3. What are computer hardware enlist a few?

Q4. What are softwares and its types?

Q5. What are application softwares and its types?

Q6. What are system softwares and its types?

Q7. What are the various applications of IECT?

Multiple Choice Questions

Q1. What is the format of computer processing a)  Output-cpu-

input b)  input-cpu-output c¢) Both of these d) None of the above Q2.
What are the types of computer memories?
a) Primary b) Secondary c) Hard Diskd) A and B

Q3. Keyboard is an
a) Hardware b) Softwarec) Memory Device d) None.

Q4. is a secondary storage device?

a) Speakers b) Internal Hard Disk c) Pen Drived) Mouse Q5. What
is the computer screen refered to as?

a) Visual display unit or monitor b) Glassc) Tvd) None of the above
Q6. Thereare __ types of softwares?

a) 1

b) 2

¢ 3

d) 4

Q7. What is the full form of L.LE.C.T.?

a) Indian Electronics and Computer Training.

b) International Electrical and Computer Tribunal.

c¢) Information Electronics and Communication Technologies.

d) None of the above.

Q8. A computer has types of memories a) 4
b) 6
c) 8
d 2
Answers : 1-b; 2-d; 3-a; 4-c; 5-a; 6-b; 7-c; 8-d True and Fales

1.  Computer is a man made device.
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Computer can be used to feed data.

Computer has 4 types of memories.

CDs are an example of primary memory.

Softwares are of 2 types.

Utility programs are a part of application softwares.

Primary memory is long lasting.

Software is a device that processes the input.

Keyboard is an output device.
Answers: 1-true; 2-true; 3-false; 4-false; 5-true; 6-false; 7-false;
8-true; 9-false.



Chapter -2

Operating Computer Using GUI Based Operating

System An operating system (OS) is an interface between hardware and
user, which is responsible for the management and coordination of activities
and the sharing of the resources of a computer, that acts as a host for computing
applications run on the machine. Unlike a command line operating system like
Unix or MS-DOS, GUI Operating Systems are much easier for end-users to
learn and use because commands do not need to be known or memorized.
Because of their ease of use, GUI Operating Systems have become the
dominant operating system used by end-users today. Graphical User Interface,
the GUI was first developed at Xerox PARC by Alan Kay, Objectives
Every computer that receives human input needs a user interface, which allows a
person to interact with the computer. While devices like keyboards, mice and
touch screens make up the hardware end of this task, the user interface makes up
the software for it. The two most common forms of a user interface have
historically been the Command-line interface, where computer commands are
typed out line-by-line, and the Graphical user interface, where a visual

environment (most commonly with windows, buttons, and icons) is present.

Basics of popular operating system

Most of the operating systems perform the following important functions: 1.
Processor management, that is, assignment of processor to different
tasks being performed by the computer system.

2. Memory management, that is, allocation of main memory and
other storage areas to the system programmes as well as user programmes
and data.

3. Input/output management, that is, coordination and assignment

of the different output and input device while one or more programmes are
being executed.

4. File management, that is, the storage of file of various storage
devices to another. It also allows all files to be easily changed and
modified through the use of text editors or some other files manipulation
routines.

5. Establishment and enforcement of a priority system. That is, it
determines and maintains the order in which jobs are to be executed in the



computer system.

6. Automatic transition from job to job as directed by special
control statements.

7. Interpretation of commands and instructions.

8. Coordination and assignment of compilers, assemblers, utility
programs, and other software to the various user of the computer system.
9. Facilities easy communication between the computer system
and the computer operator (human). It also establishes data security and
integrity.

The User Interface

A user interface (UI) brings structure to the interaction between a user and the
computer. In the last decade, almost all development in user interfaces has been
in the area of the graphical user interface (GUI), with two models, Apple's
Macintosh and Microsoft's Windows, receiving most of the attention and gaining
most of the market share. The popular open-source Linux operating system also
supports a graphical user interface.

Task Bar

A bar located at the bottom of the screen that was first introduced
with Microsoft Windows 95 and found in all versions of Windows after that.
The Taskbar allows the user to locate and launch programs through the Start
button, see any program that is currently open, display the time or date, items
running in the background through the Systray, and with subsequent versions of
the Windows operating system, the Quick Launch.
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Windows 98 Taskbar W W || 32 | 95/209
Windows 7 Taskbar In the above two pictures, are examples of differences
between Windows Taskbars. First, the Windows 98 Taskbar is an example of
what the Taskbar looks like in many of the earlier versions of Microsoft
Windows. As can be seen by this picture, this Taskbar has the Start button, the
Quick launch area, the currently running programs, and the Systray and system
time.
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Taskbar elements

As stated above there are several elements located within the taskbar, here is a
description of each of the basic elements you will find.

Icons

Start button- the Start button gives you access to the start menu that
gives the user an easy way to access and navigate programs,
documents and computer settings.

The Quick Launch Bar - with this element, you can access shortcuts
to applications. You will find that there is a default set up for the quick
launch bar that includes IE explorer, MS Office (if available), etc.
Taskbar Buttons- When you open an application in Windows, you
should see a small tab located in the taskbar. Since most applications
take up the full screen (e.g. Word and IE), using the taskbar buttons by
clicking on it with your mouse can easily help you navigate from one
open application to another. If you have several applications running
you should see them all listed as taskbar buttons on the taskbar
Notification Area- while commonly referred to as the system tray
(which is incorrect), the notification area contains a place to show you
the status of programs, a clock (by default) and when a specific task is
in process (e.g. printing a page).

Customization of the What is the Windows Taskbar?It should be
noted that with many of the visual elements of Windows, you can
easily customize the taskbar. For instance, you can change the taskbar
from being located horizontally on the bottom of the screen to
vertically on either side of your screen or even at the top of your
screen.

A graphic symbol that denotes a program or a command or a data file or a



concept in a graphical user interface.
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There are thousands of icons in windows Oprating system. Some important icons
are categorized into six groups and shown in the above figure. File management
icons are used for storing and retrieving files and folders within the system.
Database management icons are used for accessing different types of databases.
Office Icons are used for accessing office application. Internet access icons are
used for upload and download files from the internet. Multimedia icons are used
for accessing audio and video files. Utility Icons are used.

Computer Menu
The Start menu is the main gateway to your computer's programs, folders, and
settings. It's called a menu because it provides a list of choices, just as a

restaurant menu does. And as "Start" implies, it's often the place that you'll go to
start or open things.

Use the Start menu to do these common activities:

. Start programs

. Open commonly used folders

. Search for files, folders, and programs

. Adjust computer settings

. Get help with the Windows operating system

. Turn off the computer

. Log off from Windows or switch to a different user account

Getting started with the Start menu To open the Start menu, click
the Start button @ in the lower-left corner of your screen. Or, press
the Windows logo key #Fon your keyboard. The Start menu appears.
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The Start menu is divided into three basic parts:

e The large left pane shows a short list of programs on your computer.
Your computer manufacturer can customize this list, so its exact
appearance will vary. Clicking All Programs displays a complete list
of programs (more on this later).

e In the lower left corner is the search box, which allows you to look
for programs and files on your computer by typing in search terms.

e The right pane provides access to commonly used folders, files,
settings, and features. It's also where you go to log off
from Windows or turn off your computer.

Running an Application

Running an application in GUI based operating system is easy enough. Just
double click on the icons of an application. If icon is not available in your
desktop then create shortcut in desktop. Otherwise you click on Start Menuthen
click on Run and type the name of the application in the textbox and press enter.

Operating Systems Simple Settings



Changing System Date and Time

1. Right-click on the time in the bottom-right of the screen and
select Adjust Date/Time.

Toolbars »

Adjust Date)Time

Zustomize Motifications. ..

Show the Deskiop
Task Manager

v Lock the Taskbar
Properties

l £5* %y (B 4129 PM

2. Use the arrows to the right of the month/year and the arrows to the
right of the clock to change the time to the correct time.

Changing Display Properties
1. Click Start , and then click Control Panel . The Control Panel
window will open.
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2. From the Control Panel window, double-click Display . The Display
Properties window will open.
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3. In the Display Properties panel, click the Settings tab.Settings tab —
XP




6.
7.

To change the screen area size, click the slide under Desktop area .
Drag the slide to the left to decrease the screen area, or to the right to
increase the size area.

To change the number of colors, select the desired quality from the
drop-down menu under Color quality .When using more colors, the
pictures and images will appear more realistic; however, more display
memory is used and the display refresh time is slower.

Click Apply, and then click OK to save the settings.

Close the Display Properties windows

To Add a Windows Component

1.
2.

Log on as Administrator or as a member of the Administrators group.

Click Start, click Control Panel, and then double-click Add or
Remove Programs.

Click Add/Remove Windows Components. The Windows
Components Wizard starts.

In the Components list, click to select the check box that is next to
the component that you want to add. If the check box for a
component is shaded, only some of its subcomponents are selected
for installation.

To view a list of the subcomponents, click Details. Click to select the
check box next to the subcomponents that you want to add, and then
click OK. If the Details button is unavailable, the component does not
contain subcomponents.

Click Next.

If the Imsert Disk dialog box appears, use one of the following

methods:

o Insert your Windows XP CD-ROM into your CD-ROM or DVD-
ROM drive, and then click OK.

o C(Click OK to locate your Windows XP installation files. In
the Files Needed dialog box, click Browse, locate your
Windows XP installation files, and then click Open. For
example, the installation files might be in the D:\I386 folder.

In the Completing the Windows Components Wizard screen,
click Finish.

To Remove a Window Component



1. Log on as Administrator or as a member of the Administrators group.

2. Click Start, click Control Panel, and then double-click Add or
Remove Programs.

3. Click Add/Remove Windows Components. The Windows
Components Wizard starts.

4. In the Components list, click to clear the check box next to the
component that you want to remove. Note that a shaded check box
next to a component indicates that only some of its subcomponents
are installed.

If you want to remove a subcomponent, click Details. Then, click to
clear the check box next to the subcomponents that you want to
remove, and then click OK.

5. Click Next.

6. In the Completing the Windows Components Wizard screen,
click Finish.

Changing Mouse Properties

With your computer logged into Windows you should have the desktop loaded.
In the lower left corner of the screen click the 'Start' button. A vertical menu will
pop up. On the right of the pop up start menu are many commonly used items.
As pictured 'Control Panel' is one of these items. Click the 'Control Panel' option
on the start menu.
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The control panel will load showing all of the available settings. You will see an
icon for 'Mouse' which we have highlighted in the picture. With your mouse,
double click the 'Mouse' icon. The Mouse properties window will appear.
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With the mouse settings you can switch the left and right buttons and change the
double click speed. At the top of the displayed window you will see a picture of
a mouse with the left mouse button highlighted. To the left is a checkbox
labelled 'Switch primary and secondary buttons'.

Below this is the double click speed setting which allows you to adjust how
responsive the double click is to suit your clicking style. To alter the mouse click
speed move the slider between slow and fast by click and holding the left mouse
button and dragging the mouse.
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To change the buttons for a left handed person tick the 'Switch primary and
secondary buttons' and you will see as in our example that the highlighted button
is now the right hand side button. This means that you use the right hand button
to select and click items and the left hand button to produce menus. To revert the
setting back you may have to right click the checkbox to switch the buttons
back.
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Click the "Pointers' tab allows you to change the cursor look. You will see a drop
down box under the scheme heading which by default says 'None'. Click the
drop down box and you will see a list of available cursor schemes to choose
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You will see in the centre of the pointers window is a preview box that shows all
the cursor styles for the selected scheme. If you are happy with the selected
scheme, click 'Ok’ or choose another from the drop down menu. Click the
'Pointer Options' tab along the top of the mouse properties window.

In the pointer options settings you can change the speed at which the cursor
moves in relation to you moving the mouse. To adjust this speed move the slider
between the slow and fast labels. You can see the other settings that are
available. To enable a setting tick the checkbox. To disable a setting untick the
checkbox.
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Click the 'Wheel' tab at the top of the mouse properties window. You will see the
option to change how the mouse scroll wheel operates. You can see that you can
have the screen scroll more or less with each turn of the wheel or you can select
to have one page scroll in one go. Once you have made changed to the mouse
settings click the 'Ok’ button at the bottom of the mouse properties box to exit.

Adding A Printer

If your printer doesn’t connect via USB, and you don’t have setup instructions or
drivers, follow these steps.

1. Turn off the PC and connect the printer. Power on both the PC
and the printer.

2. In Windows 7, click Start, Devices and Printers. In Vista,
click Start, Control Panel, Hardware and Sound, Printers.

3. Click Add a printer.

4. If the printer is physically connected to the PC, click Add a

local printer. If the printer is connected wirelessly or over a network, skip
to Step 5.
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4a. Select Use an existing port, and then choose your printer port
from the drop-down list. The default LPT1 selection is highly likely to be
correct. Click Next.

4b. Select your printer manufacturer and model from the two
lists. If your model is not listed and your system is connected to the
Internet, click the Windows Update button. If you have a driver on a disk
or CD, or if you downloaded a file, click Have Disk... to point Windows to
the driver you want to use. Click Next.

4c. Assign a custom name to your printer, if you want an easy
way to identify it. Click Next.
4d. If prompted, select a sharing option. If you are unsure what to

do, select Do not share this printer. Click Next.

4e. Click Print a test page to confirm a successful installation.
Click Finish.



5. If your printer is connected wirelessly or over a network,
click Add a network, wireless or Bluetooth printer.

5a. Select the printer you would like to install from the list.
Click Next.

5b. If prompted, click Install driver. Click Next.

5c. Click Print a test page to confirm a successful installation.
Click Finish.

Removing a Printer

1. In Windows, click Start, Control Panel, Hardware and Sound,
Printers.
2. Right-click the printer you wish to remove, click Delete.

File & Directory Management

A file is a place where one can keep all his documents falling under a specific
heading in one place. The File menu is where you open, save, and create new
files.

1. Click the File menu in the program you are using, and then
click New.



If you can create more than one kind of file in the program, you might
also need to select an item, such as a template, from a list.

2. When you are finished working with the new file, click
the File menu, and then click Save As to name the file and save it on
your computer.

Renaming of a File

In order to rename a file one can select the file in the folder, right click on the
file and follow the option of rename. After clicking on rename, we can type the
desired name and press enter.

Common Utilities

Utility software is a kind of system software designed to help analyze, configure,
optimize and maintain the computer. A single piece of utility software is usually
called a utility or tool.

Disk storage or disc storage is a general category of storage mechanisms, in
which data are digitally recorded by various electronic, magnetic, optical, or
mechanical methods on a surface layer deposited of one or more planar, round
and rotating platters. Disk defragmenters can detect computer files whose
contents are broken across several locations on the hard disk, and move the
fragments to one location to increase efficiency.

Backup utilities can make a copy of all information stored on a disk, and restore
either the entire disk (e.g. in an event of disk failure) or selected files (e.g. in an
event of accidental deletion).

Archive utilities output a stream or a single file when provided with a directory
or a set of files. Archive utilities, unlike archive suites, usually do not include
compression or encryption capabilities. Some archive utilities may even have a
separate un-archive utility for the reverse operation.

Model Question and Answer

Q1. What is operating system?

The operating system is the interface between user and hardware, that is
responsible for the management and coordination of activities and the
sharing of the resources of a computer.

Q2. What are the Basic Functions of an Operating System?
1. Process management 2. Memory Management
3. File management



4, Input & Output Device Management etc.

Q3. What are the Basics of popular operating systems Most of
the operating systems perform the following important functions: 1.
Processor management, 2. Memory management, 3.
Input/output management, 4. File management,
5. Establishment and enforcement of a priority system.
6. Automatic transition from job to job as directed by special

control statements.

Q4. Why GUI is more popular than Command-line interface?

Ans. GUI is more popular than Command-line interface because in GUI
there is no need to remember the command syntax. Just click on the menu
and submenu which replace the Command in GUI.

Q5. Where the task bar is located in the window and what its
function is?

Ans. A taskbar is a bar displayed on a full edge of a GUI desktop
that is used to launch and monitor running applications.

Q6. How can we change the Screen Saver of the computer
screen?

Ans. Right click on the desktop and choose properties then click
on the Screen Saver tab and choose screen saver from the drop down list.
Q8. How can we set the Date and Time in a computer?

Ans. Click on start menu then click on setting and then on
control panel .Within the control panel click on date and time icon.

Qo. How to rename a file or folder?

Ans. Right click on the name of the file and folder a pop up menu

appear then select Rename and type the new name.

Q10. How to remove a window component ?

Ans. By following the undersaid step we can remove a window

component :-

1. Log on as Administrator or as a member of the Administrators group.

2. Click Start, click Control Panel, and then double-click Add or
Remove Programs.

3. Click Add/Remove Windows Components. The Windows
Components Wizard starts.

4. In the Components list, click to clear the check box next to the



component that you want to remove. Note that a shaded check box
next to a component indicates that only some of its subcomponents
are installed.

If you want to remove a subcomponent, click Details. Then, click to
clear the check box next to the subcomponents that you want to
remove, and then click OK.

5. Click Next.

6. In the Completing the Windows Components Wizard screen,
click Finish.

Q11. What is the screen of a computer refer to as?
Ans. Desktop

Q12. Examples of Operating systems?
Ans. Windows and MS DOS.

Questions for self practice

Q1. What is an operating system?

Q2. What are the basics of popular operating systems?
Q3. How can we change date and time in a system?
Q4. How can we add a printer to the system?

Q5. How can we remove a printer from a system?

Q6. How can we make a change in mouse properties?
Q7. How can we remove a window component?

Multiple Choice Questions

Q1. Which of the following are the basics of operating systems
a) Process management b) Memory management c) Files
Management.

d)  All the above Q2. These are an example of operating
systems.

a) MS Dosb) Windows c) Both A and B
d) None of the above.

Q3. Which of these are a part of computer menu?

a) Start programs b) Open commonly used folders ¢) Search for files,
folders, and programs d) All The Above.



Q4.

a)
b)
d)

Q5.

b)
)
Q6

a)
d)
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Which of the following is not a taskbar element?
Start Button.
Printer ¢) Quick Launch Bar.
Notification Area.

What is the Full Form of GUI a) Graphical User Interface.
General User Interface.

Geographical User Interface d) None of the above.

An operating system (OS) is an interface between and

Computer and internet b) Hardware and user c) Printer and CPU
None Answers : 1-d; 2-c; 3-d; 4-b; 5-a; 6-b True and False

Is an operating system an interface between user and hardware.
Memory management is not a basic of an operating system.

A window component can never be removed from a computer.
We cannot change or modify mouse properties.

We can load a new printer to the computer.

We can change or set date and time of a computer.

MS DOS is a kind of an operating system.

Windows is not an operating system.

UI stands for user interface.

Computer screen is refered to as a desktop.

Answers: 1-true; 2-false; 3-false; 4-false; 5 — true; 6-true; 7-true; 8-false;
9-true; 10-true.



Chapter 3

Understanding Word Processing

Using a computer to create, edit, and print documents. Of all computer
applications, word processing is the most common. To perform word processing,
you need a computer, a special program called a word processor, and a printer. A
word processor enables you to create a document, store it electronically on
a disk, display it on a screen, modify it by entering
commands and characters from the keyboard, and print it on a printer.

Introduction To Microsoft Word

Microsoft Word is (practically speaking) “identical” on both the Macintosh and
Windows computer platforms. Thus we can learn to use the Macintosh version
of Word on an IBM compatible and visa-versa. While we will be using
Microsoft Word as our word processing program, many of the techniques we’ll
cover are applicable on other word processing programs as well.

Most Microsoft programs allow a minimum of 3 different ways to accomplish
any single task. It isn’t necessary for you to learn all three. Simply pick the
method, which best fits your personality type. I personally like the Hot Keys,
which allow me to keep my hands on the keyboard. Please note that Mac and PC
Hot Keys are the same except the PC always uses the Control Key Ctrl along
with another key and the Mac always uses the Command Key(Apple) Key along
with another key. For Example: Undo on the PC is Ctrl+Z: Undo on the Mac
is (Apple)Z
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How To Start Microsoft Word
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Startmg Word

e via Start Menu (PC Only): Click on the START Menu (usually the
lower left-hand side of the screen) and select “Microsoft Word” from
the “Programs” Folder.

e via the Microsoft Office Manager: The Microsoft Office Manager,
is an optional toolbar which floats around on the Window’s desktop.
On the Mac, its found as a menu option (near help).

e via the Desktop (Word in the MS Office Folder): Open “My
Computer”, open “C:”, open “Programs”, open “Microsoft Office”,
and then double click on “Microsoft Word”.

Basic Components of MS Word Menu Bar

MS Word offers a variety of operation, right from typing data to adding statistics
to taking prints and making it attractive. The menu bar offers the following list



of heads with variety of operations.
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File Options
File options in MS word offers opening of new documents, saving documents,
printing, importing and exporting files etc.
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Using Help
Word is a user friendly software, it offers simplicity in operations and if at all
there is any information and problem that the user is facing, word provides the

facility of “Help” option on its menu whereby users can type their problem and
can get an online and offline support.

Opening and Closing of New Documents Opening New Documents In order
to open a new document one has to click on the file button on the top bar of the



MS Word. On opening the same the first option new appears on the screen and
by clicking on it we get a fresh document to work on.
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Save and Save As

Post typing the material on the word file, MS Word gives us an option to save
the file for future reference. We have to click on the file menu and select save
option.
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After clicking on the save option, the computer gives us the choice of saving the
file in desired directory and desired file. Post selection of directory and file we
have to click “Save”.
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Save As

In cases where we would like to make amendments to a file and save it in
another name. In that case in place of save we use the save as option in this case
and its system is same as that of save option.

Page Setup
While getting started with a new word file. We get an option of selecting a
complete page size, its margings, headers, etc. For effective page setup select the
“page layout” option from the top bar and select the desired options.

Print Preview

Its always better to see a print preview of the document before actually printing
it as in that case one can save wastage of paper, time and effort. In order to see a
print preview one has to click on the file menu, then select the print option and
further select print preview to generate preview of the document.
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Printing Of Documents After being satisfied with the print preview, we can
proceed towards printing of the documents. From the file bar select print option
and further select print option.

b R

Post selecting the print option the computer opens the print setup, whereby we
can decide on the quality, quantity, size of the page etc. On selection of all the
options as desired and then click OK.



Text Creation and Manipulation Document Creation: This is the foremost
function of Microsoft word to create documents, we have seen how to create a
new document earlier in this chapter.

Editing Text : Editing of text is very easy in MS Word. We can just use the
mouse and click on the places we want to inset text or insert spaces or make any
kind of modifications.

Text Selection : It is a feature that makes word easy to use. One can easily with
the use of a mouse select the content that he desires. Press the left button on ur
mouse and keep it pressed for the time and line you intend to select.
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Cut Copy and Paste
It is the most useful technique used for copying lines from one file and pasting it
to another file in word and other supporting softwares.

Cut: This command cuts the line selected from a file permanent and can be
pasted to another file.

Copy: This command helps in copying the content, while retaining it in the
original file even while being pasted to another file.

Paste: It is the option we click on when we have already cut or copied a file
from another file. It is used to paste the text from another file to the operating
file.
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Spell-Check and Thesaurus Word provides its users with facilities like spell
check and thesaurus under the “review” heading on the top bar. On giving the
spell check command the word in itself starts checking the wrong spelling in the
selected content on the word file. It gives a complete instruction before
correcting the spellings and asks the user if he wants to replace the spellings or
not.Thesaurus facility helps in finding the right meaning and synonymous for the
selected words from the text file.
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Formatting the Text Presentation of text is all about the format and way its
been presented. Word offers quality formatting options like line alignment, bullet
points, case, headers etc.

Alignment of Text

Word gives various facilities for alignment of text material, a user can side align
(left and right), centre align or straight align the content as per his desire. On the
home bar of the word there are aligning options available to the user. We can
select the text content and align it at wish. For aligning the text one has to select
the content and click on the options on the bar menu.
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Indenting the Paragraph Indentation determines the distance of the paragraph
from either the left or the right margin. Within the margins, you can increase or
decrease the indentation of a paragraph or group of paragraphs. You can also
create a negative indent (also known as an outdent), which pulls the paragraph
out toward the left margin. You can also create a hanging indent, in which the
first line of the paragraph is not indented, but subsequent lines are.

Indent only the first line of a paragraph

1.  Click in front of the line that you want to indent.

2. On the Page Layout tab, click the Paragraph Dialog Box
Launcher, and then click the Indents and Spacing tab.

Indent Spacing

E'F Right _ :: After

Paragraph

I

3. Inthe Special list under Indentation, click First line, and then in
the By box, set the amount of space that you want the first line to
be indented.

The first line of the paragraph and all subsequent paragraphs that you
type will be indented. However, any paragraphs before the selected
paragraph must be manually indented by using the same procedure.

Increase or decrease the left indent of an entire paragraph
1.  Select the paragraph that you want to change.
2. On the Page Layout tab, in the Paragraph group, click the
arrows next to Indent Left to increase or decrease the left
indentation of the paragraph.

Increase or decrease the right indent of an entire paragraph



Select the paragraph that you want to change.

On the Page Layout tab, in the Paragraph group, click the
arrows next to Indent Right to increase or decrease the right
indentation of the paragraph.

Set an indent by using the TAB key

1.

4.

S.

Click the Microsoft Office Button (E8 , and then click Word
Options.

Click Proofing.

Under AutoCorrection settings, click AutoCorrect Options,
and then click the AutoFormat As You Type tab.

Select the Set left-and first-indent with tabs and backspaces
check box.

To indent the first line of a paragraph, click in front of the line.

To indent an entire paragraph, click in front of any line but the first

line.

Bullets & Numbering While presenting a report or an analysis its always better
to present the highlighted or important points in the form of numbered lines or
bullet points. In word we have the edge of using bullets, pointers, numbers etc.
For our line we have to select the choice of bullet or numbering pointers from
bar menu and just enter the data.

Pammey.

Changing Case
Text can be typed in lowercase or small letters, uppercase or capital letters, or a



mix of the two cases. Have you found yourself wishing you could change the
capitalization of a section of text without having to retype the whole thing? You
can, when you use the Format | Change Case Command.Proper nouns should be
capitalized. The first word of sentences should be capitalized. Titles should be
capitalized. What if you forget? What if you capitalize where you normally
would not? You can change the case of all the text at once with a single
vcommand -- a great timesaver!

To do so:
1. Highlight the text you want to change.
2. Choose Format | Change Case. This opens the dialog box that

gives you the choice between Sentence case, lower case, UPPER CASE,
Title Case, and tOGGLE cASE. Next, choose the type of formatting you
want to use from the below choices and click OK.

Sentence case: capitalizes the first letter of the first word and
puts the rest in lowercase.

Lower case: changes everything to lowercase, with nothing
capitalized.

Title case: capitalizes the first letter of every word. Toggle case
changes capital letters to lowercase and vice versa. (You don't use this
choice much anymore because if you make a mistake such at typing
tOGGLE, using the Shift key while Caps lock is on, Word automatically
corrects it and turns off the Caps lock.) Alternatively, press the Shift+F3
shortcut key repeatedly to cycle through three formats: UPPER CASE,
lowercase and Title Case. Capitalization is under your control, even for
large amounts of text. When you use Title Case, you'll most likely have to
go back and make a few corrections. In titles, small words (such as:
articles, coordinate conjunctions, and prepositions, such as "the," "and,"
"in," "on," "for," etc.) should not be capitalized unless they are the first
word in the title.

Table Manipulation
Method 1: Create a Table by Using the Standard Toolbar
1.  Click where you want to create a table.
On the Standard toolbar, click Insert Table.

2.
3. Drag to select the number of rows and columns that you want.
4.

When you finish creating the table, click into a table cell, and then
either start typing or insert a graphic.



Method 2: Create a Table by Using the Table Menu

1.
2.
3.

Click where you want to create a table.
On the Table menu, point to Insert, and then click Table.
In the Imsert Table dialog box, change Number of

columns and Number of rows to the size that you want for your
table, and then click OK.

For example, change Number of columns to 5, and change Number of
rows to 2.

4.

When you finish creating the table, click into a table cell, and then
either start typing or insert a graphic.

Method 3: Draw a Table by Using the Tables and Borders Toolbar

1.

On the View menu, point to Toolbars, and then click to select Tables
and Borders to display the Tables and Borderstoolbar.

On the Tables and Borders toolbar, click Draw Table (the pencil
icon). The mouse pointer changes to a pencil.

To draw your table, position the pencil in the document where you
want the insert the table, and then click and drag to draw a line from
one corner of the table to the corner that is diagonally opposite. This
action defines the boundary of the entire table.

To add columns and rows, click where you want to insert the column
or row, and then drag to draw your new column or row.

To turn off the table drawing tool, click Draw Table (the pencil icon)
on the Tables and Borders toolbar.

When you finish creating the table, click into a table cell, and then
either start typing or insert a graphic.

How to Create a Table Inside Another Table (Nested Tables)

1.
2.

On the Tables and Borders toolbar, click Draw Table.
Position the pencil in the cell where you want the nested table (a table
inside another table).

Draw the new table. To define the table boundaries, draw a rectangle.
Then draw the column and row lines inside the rectangle.

How to Change the Width and Height of Table Columns and Rows

Change the Column Width in a Table

Rest the pointer on the column boundary that you want to move until the pointer
becomes a horizontal two-pointed arrow, and then drag the boundary until the



column is the width that you want.

NOTES:

e To change a column width to a specific measurement, click a cell in
the column. On the Table menu, click Table Properties, and then
click the Column tab. Choose the options that you want.

e  To make the columns in a table automatically fit the contents, click to
select the table, point to AutoFit on the Tablemenu, and then
click AutoFit to Contents.

e To display column width measurements, click a cell and then hold
down ALT as you drag the markers on the ruler.
Change the Row Height in a Table

Rest the pointer on the row boundary that you want to move, until the pointer
becomes a vertical two-pointed arrow, and then drag the boundary.

NOTES:

e To change a row height to a specific measurement, click a cell in the
row. On the Table menu, click Table Properties, and then click
the Row tab. Select the options that you want.

e To display row height measurements, click a cell, and hold down
ALT as you drag the markers on the vertical ruler.
Make Multiple Rows or Columns the Same Size
1.  Select the columns or rows that you want to make the same size.
2. On the Tables and Borders toolbar, click Distribute Columns
Evenly or Distribute Rows Evenly.
How to Add Columns and Rows to an Existing Table
Do one or more of the following:

¢ To add a new row above or below an existing table row, click into the
table row. On the Table menu, point to Select, and then click Row.
On the Table menu, point to Insert, and then click Rows
Above or Rows Below.

-Or-

e To add a row at the end of a table, click into the last cell of the last
row of your table, and then press the TAB key to create a new table
row.

_OI‘_



e To add a new column to the left or right of an existing column, click
into a table cell of the column. On the Table menu, point to Select,
and then click Column. On the Table menu, point to Insert, and then
click Columns to the Left or Columns to the Right.

_OI‘_
e To add a column to the right of the last column in a table, click just

outside the rightmost column. On the Table menu, point to Insert,
and then click Columns to the Right.

How to Add and Remove Borders and Shading from Tables

NOTE: When you insert a table, it has a black, one-half point, solid, single-line
border by default. The following methods discuss how to add a different border
or delete the existing border.
Method 1: Use the Eraser Tool

1.  Click Eraser (eraser icon) on the Tables and Borders toolbar.

2. Click to select one of the borders of the table.

3. After you click and release the mouse, the table border will be
erased.

4. Continue this procedure until each border of the table is erased.
NOTE: The Eraser tool can only be used to remove borders or merge cells, not
to apply borders. For additional information about what to do if text is removed

from a table when you use the Eraser, click the article number below to view the
article in the Microsoft Knowledge Base:

Method 2: Automatically Format Table Borders and Shading by Using
Table AutoFormat

1.  Click the table.

2.  On the Table menu, click Table AutoFormat.

3. In the Formats box, click to select the format that you want.

4.  Click to select the options that you want.
NOTE: AutoFormat Table is also located in the Insert Table dialog box (on
the Table menu, point to Insert and then clickTable).

Method 3: Create Table Borders and Shading by Using the "Borders and



Shading" Dialog Box

1.

Do one of the following:
o To add a border to a table, click anywhere in the table.
-Or-
o To add a border to a specific cell, select the cell that you
want, including the end-of-cell marker.
On the Format menu, click Borders and Shading, and then click to
select the Borders tab.

Use the Setting, Style, Color, and Width options to add a different
border. Make sure the appropriate option (Tableor Cell) is selected in
the Apply to box.

To specify that borders are applied only to specific sides,
click Custom under Setting. Under Preview, click the diagram's
sides, or use the buttons to apply and remove borders.

To specify the exact position of the border relative to the text,
click Paragraph under Apply to, click Options, and then select the
options that you want.

Method 4: Create Table Borders and Shading by Using the "Tables and
Borders" Toolbar

1.

Display the Tables and Borders toolbar by pointing to Toolbars on
the View menu, and then clicking Tables and Borders.

Click anywhere in the table.

On the Tables and Borders toolbar, use the options that you want:

o  Click the Borders button to select the border that you want.
By default, the Borders button displays the Outside
Borders ScreenTip, but it may display the most recently used
border instead.

NOTE: Borders is also located on the Formatting toolbar.

o Change the Line Style box to the line style that you want.
o Change the Line Weight box to the line weight that you want.
o Change the Border Color box to the color that you want.

o Change the Shading Color box to the color that you want to
apply to the cells or to the entire table.

How to Change the Position or Direction of Text in a Table
Change the Text Orientation of a Table Cell



1. Click the table cell that contains the text that you want to
change.
2. Do one of the following:

o On the Format menu, click Text Direction.

-Or-
o On the Tables and Borders toolbar, click Change Text
Direction.

e  C(lick the orientation that you want.

Change the Text Alignment of a Table Cell
1. Click the table cell that contains text that you want to align.

2. On the Tables and Borders toolbar, select the option for the
horizontal and vertical alignment that you want (for example, Align
Bottom Center or Align Top Right).

How to Position a Table on the Page
Change the Alignment of a Table by Using Table Properties
1. Click to select the table.
2. On the Table menu, click Table Properties.
3. On the Table tab, under Alignment, select the option that you want.
For example, to indent a left-aligned table, type a number in
the Indent from left box.

TIP: To quickly align a table on a page, select the table, and then use
the alignment buttons on the Formatting toolbar.
Move a Table by Using the Table Move Handle

1. Rest the pointer on the table until the table move handle appears on
the upper-left corner of the table.

2. Rest the pointer on the table move handle until a four-headed arrow
appears.
3. Drag the table to the new location.

Model Questions and Answers

Q1 How to Open a Word Document?

Ans. Microsoft Word can be opened in 3 ways :-
e via Start Menu (PC Only): Click on the START Menu (usually the



lower left-hand side of the screen) and select “Microsoft Word” from
the “Programs” Folder.

e via the Microsoft Office Manager: The Microsoft Office Manager, is
an optional toolbar which floats around on the Window’s desktop. On
the Mac, its found as a menu option (near help).

e via the Desktop (Word in the MS Office Folder): Open “My
Computer”, open “C:”, open “Programs”, open “Microsoft Office”,
and then double click on “Microsoft Word”.

Q2. How to use spell check and thesaurus in MS Word?

Ans. Word provides its users with facilities like spell check
and thesaurus under the “review” heading on the top bar. On giving the spell
check command the word in itself starts checking the wrong spelling in the
selected content on the word file. It gives a complete instruction before
correcting the spellings and asks the user if he wants to replace the spellings
or not. Thesaurus facility helps in finding the right meaning and
synonymous for the selected words from the text file.

Q3. What is Cut, Copy and Paste ?
Ans.

Cut: This command cuts the line selected from a file permanent and can be
pasted to another file.

Copy: This command helps in copying the content, while retaining it in the
original file even while being pasted to another file.

Paste: It is the option we click on when we have already cut or copied a file
from another file. It is used to paste the text from another file to the
operating file.

Q4. How to Select text in word file?

Ans. It is a feature that makes word easy to use. One can easily with
the use of a mouse select the content that he desires. Press the left button on
ur mouse and keep it pressed for the time and line you intend to select.

Q5. How to change the font size in word document?

Ans. To change the font size of text within Microsoft Word, follow
the below steps.

1. Highlight the text you wish to change the size of.

2. Click the down arrow next to the size on the format bar. Often,
the default size is 12, as shown in the above example.



3. After clicking the down arrow for the font, you should have a
selection of different sizes to select from. Some fonts may not scale
properly so some fonts may only have a few size options and sometimes
may only have one.

4. If you do not have any text to highlight or wish to type text in a
different size, move the cursor to the location of where you want to new
text, click the down arrow on the size option on the formatting toolbar and
select the size you wish to use.

Q6. What are the steps for printing a word document?

Ans. Steps for printing a word document: 1. On the File

menu, click Print.

2. Under Page range, specify the portion of the document you want to print.
4. O.K.

Q7. How to use save and save as in word documents ?

Ans. Post typing the material on the word file, MS Word gives us an
option to save the file for future reference. We have to click on the file menu
and select save option. After clicking on the save option, the computer gives
us the choice of saving the file in desired directory and desired file. Post
selection of directory and file we have to click “Save”.

Save As

In cases where we would like to make amendments to a file and
save it in another name. In that case in place of save we use the save as
option in this case and its system is same as that of save option.

Questions For Self Practice Q1. How to print a word document?
Q2. How to see a print preview of a word file?

Q3. How to save a word document?

Q4. How to insert a picture or a clipart in a word file ?

Q5. Write a short note on paragraph indenting in a word file.

Q6. How to add table to a word file?






Chapter 4

Using Spreadsheet

Excel is an electronic spreadsheet program that can be used for storing,
organizing and manipulating data. When you look at the Excel screen (refer to
the example on this page) you see a rectangular table or grid
of rows and columns. The horizontal rows are identified by numbers (1,2,3) and
the vertical columns with letters of the alphabet (A,B,C). For columns beyond
26, columns are identified by two or more letters such as AA, AB, AC.

The intersection point between a column and a row is a small rectangular box
known as a cell. A cell is the basic unit for storing data in the spreadsheet.
Because an Excel spreadsheet contains thousands of these cells, each is given
a cell reference or address to identify it.

Elements of Electronic Spreadsheet
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Active Cell

In a worksheet, the cell with the black outline. Data is always entered into the
active cell.

Formula Bar

Located above the worksheet, this area displays the contents of the active cell. It
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can also be used for entering or editing data and formulas.

Name Box Or Cell Address

Located next to the formula bar, the Name Box displays the cell reference or the
name of the active cell.

Column [ etter

Columns run vertically on a worksheet and each one is identified by a letter in
the column header.

Row Numbers

Rows run horizontally in a worksheet and are identified by a number in the row
header.
Together a column letter and a row number create a cell reference. Each cell in

the worksheet can be identified by this combination of letters and numbers such
as Al, F456, or AA34.

Sheet Tab

Switching between worksheets in a Microsft Excel file is done by clicking on the
sheet tab at the bottom of the screen.

Opening a Spreadsheet In order to open a spreadsheet, one can click on the
“Start” button and then select “Microsoft Office” and from sub parts select
Microsoft Excel”.
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Printing of Spreadsheet In order to print a spreadsheet one has to click on the
“office button” and then select “print option”. Print option gives various options
like “print preview” to preview the file before printing. Secondly it gives an
option of “Print”.
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After selecting the last “Print” option. The excel sheet will open printer options,
whereby we can choose the printer, page size, quality, copies etc.

[ print |2 S| |
Printer
Mame: g Canon R2270IR2870 UFR 1T |E| Propertes, ,,
Status:  Off Line ==
Type:  Canon RZ2T0/R2870 UFR 1T 0 EYEe s
‘Where: 152,168.79.62_1
Comment:
| Print to file
Print range Copes
@ al Mumber of copies: |l
Page(s) From: = Im
Print what 1] rJ .
T b [V Collate
Selection Entire workiook ﬂih j
@ Active sheet(s) Tabie
Ignore print areas
Preview [ ox ][ conel
&1
Saving Workbooks

Following steps are taken in order to save the work file

Step 1 : open the office button Step 2 : Select the save option.
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Step 3 : If the file is an existing file and a new file is to be saved then select
“Save As” option.

Step 4 : Select the directory or file where the worksheet is to be saved.

Manipulation of Cells Entering Texts, Numbers and Dates In order to enter text
in a excelsheet select a cell, double click on that cell and start entering the text
“Excel is good”. Use tab button to move to the cell on the right hand side after
typing in the first cell.



Repeat the same exercise in order to enter numerical or number data in the excel
sheet. In order to enter dates in excelsheets we have to use dd/mm/yyyy format
like for 1* april 3013, it will be typed as 01/04/2013.

Creating Text, Numbers and Dates Series For creating text series in excel we
have to follow the following steps :-
1. Select any blank cell from worksheet and Type alphanumeric value.
2. Select Fill’ option from Edit menu.
3. Choose Series from Fill sub menu and appear ‘Series’ dialogue box.
4. Type step value of series into ‘Step Value’ box and type last value of
list into ‘Stop Value’ box.
5. Click on ‘OK” button.

Creating Number Series In order to create a number series in excel follow the
following steps

1. Select any blank cell from worksheet and Type number.

2. Select ‘Fill’ option from Edit menu.

3. Select Series from Fill sub menu and appear ‘Series’ dialogue box.

4. Type step value of series into ‘Step Value’ box and type last value of

list into ‘StopValue’ box.
5. Click on ‘OK’ button.

Creating Dates Series In order to create a date series in excel follow the
following steps

1. Select any blank cell from worksheet and Type date.

2. Select ‘Fill’ option from Edit menu.

3. Select Series from Fill sub menu and appear ‘Series’ dialogue box.

4. Type step value of series into ‘Step Value’ box and type last date of



list into ‘Stop Value’ box.
5. Click on ‘OK’ button.

Editing Worksheet Data
In order to edit worksheet data, double click on the cell in which the data is to be

modified.

(Excel data before double click)

(Excelsheet after double click) Inserting and Deleting Rows and Columns To
insert a row or column:

1. Select the row above or the column to the right of where the insertion
should occur. Or click in any cell in that row or column.

2. Choose Home - Cells and click the arrow to the right of the Insert
button to open the drop-down list for the Insert button.
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3. From the menu, choose Insert Sheet Rows or Insert Sheet
Columns.

Deleting Rows and Columns Deleting a row or column works in a similar way:
1.  Select the row(s) or column(s) you want to delete.
2. Choose Home - Cells
3.  Press Delete.

The Delete button has a drop-down list, just like the Insert button does. From it,
you can choose what you wanted to delete: cells, rows, or columns. However, in
Step 1, you select what you want to delete, so that isn’t necessary in this case;
you can simply click the button to delete what was selected.
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Insert Page Layout Formula:

Changing Cell Height and Width In order to change the height select a row or
a column and drag its lower and right side line to extend it in height and width
respectively.
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(Column and Row after extension) Formulas and Functions Formulas are the
real workhorses of an Excel 2010 worksheet. If you set up a formula properly, it
computes the correct answer when you enter it into a cell. From then on, it keeps
itself up to date, recalculating the results whenever you change any of the values

that the formula uses.
You let Excel know that you're about to enter a formula in the current cell by
entering the equal sign (=). Some formulas follow the equal sign with a built-
in function such as SUM or AVERAGE. Many simple formulas use a series of
values or cell references that contain values separated by one or more of the
following mathematical operators:

This Mathematical Operator .. ...Is Used For

+ (plus sign) Addition

- (minus sign or hyphen) Subtraction

* (asterisk) Multiplication

/ (slash) Division

A (caret) Raising a number to an exponential
power

For example, to create a formula in cell C2 that multiplies a value entered in cell
A2 by a value in cell B2, enter the following formula in cell C2: =A2*B2
To enter this formula in cell C2, follow these steps:
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1. Select cell C2.
2. Type the entire formula =A2*B2 in the cell.
3. Press Enter.

1. Select cell C2.

2. Type = (equal sign).
3. Select cell A2 in the worksheet by using the mouse or the
keyboard.

This action places the cell reference A2 in the formula in the cell.

To start the formula, type =, and then select cell A2.
4. Type * (Shift+8 on the top row of the keyboard).

5. Select cell B2 in the worksheet by using the mouse or the
keyboard.

This action places the cell reference B2 in the formula.



6. Press Enter.

Excel displays the calculated answer in cell C2 and the
formula =A2*B2 in the Formula bar.

- o
A B C D E F G

1

2 20 100 2000

3

4

5

6

7

8 i
9
10
11

If you select the cell you want to use in a formula, either by clicking it or by
moving the cellcursor to it, you have less chance of entering the wrong cell
reference.

Now comes the fun part: After creating a formula that refers to the values in
certain cells (rather than containing those values itself), you can change the
values in those cells, and Excel automatically recalculates the formula, using
these new values and displaying the updated answer in the worksheet. Using the
example shown in the figures, suppose that you change the value in cell B2 from
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100 to 50. The moment that you complete this change in cell B2, Excel
recalculates the formula and displays the new answer, 1000, in cell C2

Functions

Excel provides many statistical functions in particular the Average function.
Excel provides two ways for entering function names. You can type the name of
the function in if you know it or you can use the Function Wizard.

To use the Function Wizard you can choose Function from the Insert menu or

you can click on the Function Wizard button (%) located on the Standard
toolbar.

- Select cell C12 and open the Function Wizard dialog box by either method
described above.

Observe:

Paste Function E I

Function category: Function name:

Maost Recently Used

Al AVERAGE

Financial IF

Date & Time HYPERLIME

Math & Trig COUNT

Statistical [ Frs

Lookup & Reference SIM

Database SUMIF

Tk | PMT

Logical STDEY

Infarmation _"I ;i

SUM(number1 number2,...)
&dds all the numbers in a range of cells,

=)

We want to use the AVERAGE function. The AVERAGE function will take the
average of all the numbers you list in the parentheses. The Function Wizard will
take you through setting up the formula step by step.

- Within the Function Wizard dialog box highlight the Function Category:
Most Recently Used and highlight the Function Name: AVERAGE then click on
the OK button.

The following dialog box should appear:



“BVERAGE
Number1 [Ez:E10 3 = {oy0i0050;050;00%
Murnberz i :-;J =

= AVERAGE(EZ:BL0)
Returns the average (arithmetic mean) of its arguments, which can be numbers or names,
arrays, o references that contain numbers.

Mumber1: numberl,numberZ, ... are 1 to 30 numeric arguments For which wou want
the average,

@ Formula result = AYERAGE(EZ:E10) ok I Cancel |

- Enter the range B2:B10 and then click on the OK button.
- Click on the Enter button or press the Return key to enter the

formula.
A | B | C |

1 |Grades

2 | 76

3 g9

4 76

5 100

6 | 53

7| 89

8 21

= B5

10 98

11 |Tatal BE7 BE7

12 |Average 74 vl
Your workbook should look as follows: 12

Now that you know how to enter formulas using operators and functions, you
can practice on your "checks" workbook.

- Close Workbook3 and don't save the file.
- Open the "checks" workbook.

- Select cell F3 and enter the following formula:
F3 x| m| =F2.03

This formula will computer your balance after check 100 has been
written.

- Select cell F4 and enter the following formula:
F4 =| = =F3-D4

This formula will computer your balance after check 101 has been written.

- Select cell F5 and enter the following formula:
F5 | = =F4+800-D5

This formula will computer your balance after check 102 has been written




plus the $900 dollar deposit has been accounted for.

- Select cell F6 and enter the forumla that would compute the
balance after 103 has been written.

Your "checks" workbook should look as follows:
A | B | C i D | E | F |
1 |Mumber Diate Description  Payment Amount | Deposit Amount Balance
2 Eey. Balance 300
0] 100 Almacs 89.54 210.46
4 101 My e 56.1 154,36
5 102 Sue Fisher 235.13 800 819.23
B 103 EMG 76.35 742.688
i
5]

If something is incorrect in your "checks" workbook, go back and check
over your formulas.

- Save your changes.

- Starting in cell B3, build the following table:
A i B I
Murmber Date

100 8-Aug-Hh
101 10-Aug-96
1020 13-Aug-56

103 20-Au ?-95
L ]

You will learn how to format the dates, headings, and dollar amounts in the next
part of the tutorial.

Model Question and Answers
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Q1. What is Microsoft excel?

Ans. Excel is an electronic spreadsheet program that can be used for
storing, organizing and manipulating data.

Q2. How to print an excelsheet?

Ans. In order to print a spreadsheet one has to click on the “office
button” and then select “print option”. Print option gives various options
like “print preview” to preview the file before printing. Secondly it gives an
option of “Print”.
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Q3. How can we create data series in excel?
Ans. In order to create a date series in excel follow the following
steps
1. Select any blank cell from worksheet and Type date.
2. Select ‘Fill’ option from Edit menu.
3. Select Series from Fill sub menu and appear ‘Series’ dialogue box.
4. Type step value of series into ‘Step Value’ box and type last date of list
into ‘Stop Value’ box.
5. Click on ‘OK’ button.
Q4. How to Delete a row or a column in excel?

Ans. Deleting a row or column works in a similar way:
1. Select the row(s) or column(s) you want to delete.
2. Choose Home - Cells
3. Press Delete.
Q5. How can we change the height and width of a cell in excel?

Ans. In order to change the height select a row or a column and
drag its lower and right side line to extend it in height and width
respectively.

Questions for self practice.

Q1. What is Microsoft excel?

Q2. How can we enter text into an excelsheet?

Q3. What is the format for entering dates into excelsheet?
Q4. What are the steps of saving an excelsheet?

Q5. How can we see a print preview in an excelsheet?

Q6. How can we perform multiplication in excel ?



Chapter -5

Communication Using The Internet

The Internet is a global network connecting millions of computers. More than
100 countries are linked into exchanges of data, news and opinions. The Internet
is more of a concept than an actual tangible entity, and it relies on a physical
infrastructure that connects networks to other networks.

Computer Networks Two or more computers connected together through a
communication media form a computer network.The computers are connected in
a network to exchange information and data. The computers connected in a
network can also use resources of other computers.

Computer Network Components There are different components of a network.
Following are the basic components of network.

1. Server: Powerful computers that provides services to the other
computers on the network.

2. Client: Computer that uses the services that a server provides.
The client is less powerful than server.

3. Media: A physical connection between the devices on a
network.

4. Network Adopter: Network adopter or network interface card

(NIC) is a circuit board with the components necessary for sending and
receiving data. It is plugged into one of the available slots on the Pc and
transmission cable is attached to the connector on the NIC.

5. Resources: Any thing available to a client on the network is
considered a resource .Printers, data, fax devices and other network
devices and information are resources.

6. User: Any person that uses a client to access resources on the
network.
7. Protocols: These are written rules used for communications.
They are the languages that computers use to talk to each other on a
network.

Some basic types of computer networks include:
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e  Local Area Network (LAN)

It connects network devices over a relatively short distance like in a
single building or campus. LANs are typically owned, controlled and
managed by a single person and organization.

e  Wide Area Network A WAN provides long distance transmission of
data, voice, image and video information over large geographical areas
that may comprise a country, continent, or even the whole world.

Internet

The Internet is a global system of interconnected computer networks that use the
standard Internet protocol suite (TCP/IP) to serve several billion users
worldwide. It is a network of networks that consists of millions of private,
public, academic, business, and government networks, of local to global scope,
that are linked by a broad array of electronic, wireless and optical networking
technologies.

The Internet contains billions of web pages created by people and companies
from around the world, making it a limitless location to locate information and
entertainment. The Internet also has thousands of services that help make life
more convenient. For example, many financial institutions offer online banking
that enables a user to manage and view their account online.

Basic Applications of Internet

The internet is treated as one of the biggest invention. It has a large number of
uses.

1. Communication: it is used for sending and receiving message
from one and other through internet by using electronic mail. Some of the
web sites providing this service are yahoomail.com Hotmail.com
rediffmail.com etc 2. Job searches: getting information regarding
availability of job in different sectors and areas. You can publish your
resume in online for prospective job. Some of the web sites providing this

service are naukri.com, monster.com, summerjob.com,
recuritmentindia.com etc.
3. Finding books and study material : books and other study

material stored around the world can be easily located through internet.
Latest encyclopaedias are available online.

4. Health and medicine: internet provide information and
knowledge about field of health medicine people can have information
about various disease and can receive help .patient can be taken to virtual
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check room where they can meet doctors. Some of the web sites providing
this service are 5. Travel: one can use internet to gather
information about various tourist place . it can be used for booking
Holiday tours , hotels, train and flights. Some of the web sites providing
this service areindiatravelog.com, rajtravel.com, makemytrip.com.

6. Entertainment one can doun lode jokes, songs muvis, latest
sports updates through internet Some of the web sites providing this
service arecricinfo.com, movies.com espn.com 7. Shopping :

internet is also used for online shopping. By just giving accounts details
you can perform the transaction. You can even pay your bills and perform
bank related transaction.

8. Stock market updates : you can sell or buy shares while sitting
on computer through internet. Several websites like ndtvprofit.com,
moneypore.com, provide information regarding investment.

9. Research : a large number of people are using internet for
research purposes you can download any kind information by using
internet.

TCP/IP Applications

The highest-level protocols within the TCP/IP protocol stack are Application
Protocols. They communicate with applications on other internet hosts and are
the user-visible interface to the TCP/IP protocol suite. All application protocols
have some characteristics in common: - They can be
user-written applications or applications standardized and shipped with the
TCP/IP product. Indeed, the TCP/IP protocol suite includes application protocols
such as:

1. Telnet for interactive terminal access to remote internet hosts

File Transfer Protocol (FTP) for high-speed disk-to-disk file
transfers

3. Simple Mail Transfer Protocol (SMTP) as an internet mailing system
4. Most applications use Client / Server model of interaction.

Connecting to the Internet The Internet is a global network of computers that
allows rapid, worldwide communication. There are currently more than 250
million people connected to the Internet. The purpose of the Internet is to
communicate and share information.

Connecting from Home There are four main components to getting connected



to the Internet: 1. Computer:- For PC access, a 400 Mhz or faster
Processor is recommended. With Windows 95/98 at least 48 MB of RAM and
more will help increase the computer’s speed for faster Internet cruising. A
Sound Card and Speakers also are recommended so one can hear the audio
information on the Internet.

2. Modem: - A modem allows digital data to be transmitted to and
from computer over phone lines. A modem (from Modulate and
Demodulate) is a device that modulates an analog carrier signal to encode
digital information. The goal is to produce a signal that can be transmitted
easily and decoded to reproduce the original digital data. Modems can be
used over any means of transmitting analog signals, from driven diodes to
radio. Modern modems run at 56,000 bps (bits per second). This is
commonly referred to as a 56K modem.

3. Internet Service Provider (ISP):- ISPs (Internet Service
Providers) are Organizations that allow users to dial into ISP computers (for
a fee) to connect to the ISP’s Internet link. ISPs generally provide an
Internet connection and an e-mail address.

4. Software: - A Web Browser or Internet Browser is a software
application for retrieving, presenting, and traversing information resources
on the World Wide Web. An information resource is identified by a Uniform
Resource Identifier (URI) and may be a web page, image, video, or other
piece of content. Although browsers are primarily intended to access the
World Wide Web, they can also be used to access information provided by
Web Servers in private networks or files in file systems.

Basic Internet and Network Set Up People use the Internet everyday to
communicate with friends and family, gather information, find entertainment and
do much more. There are several different ways to connect with your Internet
Service provider. In most cases, connection is set up using a Dial-Up
Connection, DSL or Cable. DSL (Digital Subscriber Line) is a family of
technologies that provide digital data transmission over the wires of a local
telephone network.

Connecting to the Internet using Broadband Broadband connections to the
Internet have become more popular and affordable than ever. DSL and Cable
offer higher speed connections than Dial-Up, and also allows to connect to the
Internet without tying up with the Telephone Line, or getting a second line just
for Internet access.



Accessing the Internet through a Dial Up Account Using a Dial-Up account is
a good and inexpensive way to connect to the Internet if you primarily just check
email and do some light web browsing. Dial-Up accounts are also great if you
travel a lot, since most ISPs have access numbers throughout the country.

Troubleshooting

Losing access to one’s e-mail and favorite Web sites can be as frustrating as
picking up a dead telephone receiver. Although the problem may lie with the
ISP, it's worth knowing how to troubleshoot user’s own end of the line, too.

Model questions and answers

Q1. What are computer networks?

Ans. Two or more computers connected together through a communication
media form a computer network. The computers are connected in a network
to exchange information and data.

Q2. What are the basic types of computer networks?
Ans. Some basic types of computer networks include:

e Local Area Network (LAN)

e Wide Area Network A WAN

Q3. What do you understand by Internet?
Ans. The Internet is a global system of interconnected computer

networks that use the standard Internet protocol suite (TCP/IP) to serve
several billion users worldwide.

Q4. What is a Local Area Network?

Ans. It connects network devices over a relatively short distance
like in a single building or campus. LANs are typically owned, controlled
and managed by a single person and organization.

Q5. What is a wide area network?

Ans. Provides long distance transmission of data, voice, image and
video information over large geographical areas that may comprise a
country, continent, or even the whole world.

Questions for self practice Q1. What are computer networks?
Q2. What is a local area network?
Q3. What is a wide area network?
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Q4. What is internet?

Q5. What are the applications of internet?
Q6. What is a TCP/IP?

Q7. Basis of connecting internet from home?

Multiple Choice Questions Q1. Computer Networks are of __
types.

a) 2
b) 3
c) 4
d 5
Q2. Which of these is not a feature of a Wide Area Network.

a) Voiceb) Imagec) Small area coveraged) Video Information Q3.
The Internet is a global system of interconnected computer

a) Networksb) Ropesc) Wiresd) Screens Q4. DSL stands
for a) Digital System Line b)  Digital Subscriber Line ¢) = Domestic
sewer Line d) None of the above Q5. A modem allows digital data to be
transmitted to and from computer over .

a) Computer network b) Radio Waves c)  Phone Lines d)  Digital
Lines.

Q6. What is the full form of LAN

a) Local Area Network.

b) Local Ancilliary Network.

c) Long Area Network d) None of the above.
Answers : 1-a; 2-c; 3-a; 4-b; 5-c; 6-a True and False
Computer networks are of 4 types.

Local area network covers a long range of area.
WAN is not owned.

LAN is typically owned.

Internet has no application in the field of banking.

A modem allows digital data to be transmitted to and from computer
over phone lines.

Protocols are written rules used for communication.
8. A physical connection between devices and network is media.
Answers : 1-false; 2-false; 3-true; 4-true; 5-false; 6-true; 7-true; 8-true.
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Chapter 6

WWW & Web Browsing

World Wide Web (WWW) is the leading information retrieval service of
the Internet(the worldwide computer network). The Web gives users access to a
vast array of documents that are connected to each other by means
of hypertext or hypermedia links—i.e., hyperlinks, electronic connections that
link related pieces of information in order to allow a user easy access to them.
Hypertext allows the user to select a word from text and and thereby access other
documents that contain additional information pertaining to that word;
hypermedia documents feature links to images, sounds, animations, and movies.
The Web operates within the Internet’s basic client-server format;servers are
computer programs that store and transmit documents to other computers on the
network when asked to, while clients are programs that request documents from
a server as the user asks for them. Browser software allows users to view the
retrieved documents.

The development of the World Wide Web was begun in 1989 by Tim Berners-
Lee and his colleagues at CERN, an international scientific organization based
in Geneva, Switz. They created a protocol, HyperText Transfer Protocol (HTTP),
which standardized communication between servers and clients.

The web is the most popular Internet service next to e-mail, but it accesses a
larger quantity and greater variety of data than any other service on the Internet.
The World Wide Web or the web in short is an Internet based global information
system. It makes available multimedia information from over 4 million
computers around the world. The web offers video, interactive multimedia and
live audio, in addition to more basic data types, such as text documents and still
photographs.

Important Elements of the Web Websites Vs Web Pages A webpage is what
you see through your browser by scrolling the window up and down. A website
is composed of a group of webpages linked together. A complete website is
usually fairly self-contained, with pages created and maintained by the same
authors and often stored on a single computer. The pages may link to other pages
that are not part of that site. We'll take a look at how to find out more about


http://www.britannica.com/EBchecked/topic/291494/Internet
http://www.britannica.com/EBchecked/topic/279726/hypertext
http://www.britannica.com/EBchecked/topic/279622/hyperlink
http://www.britannica.com/EBchecked/topic/121476/client
http://www.britannica.com/EBchecked/topic/62493/Sir-Tim-Berners-Lee
http://www.britannica.com/EBchecked/topic/103555/CERN
http://www.britannica.com/EBchecked/topic/229000/Geneva
http://www.britannica.com/EBchecked/topic/279732/HTTP
http://www.britannica.com/EBchecked/topic/129024/communication

websites later in this section.

As with libraries, websites vary in size and complexity. For example, the Valley
Library's website is a distinct site, but is also part of the larger OSU website.
This tutorial is a separate website with links to various pages on the Library's site
(and elsewhere). As you'll see, both this tutorial site and the Library's site link to
many other pages on other websites.

Dynamic and Static Website A static website contains information that does
not change. It remains the same, or static, for every viewer of the site.
A dynamic website contains information that changes, depending on the viewer
of the site, the time of the day, the time zone, the native language of the country
the viewer is in or many other factors. A dynamic web site can contain client-
side scripting or server-side scripting to generate the changing content, or a
combination of both scripting types. These sites also include HTML
programming for the basic structure. The client-side or server-side scripting
takes care of the guts of the site.

Hyper Text

Hypertext is the organization of information units into connected associations
that a user can choose to make. An instance of such an association is called
a link or hypertext link. (And the highlighted word "link" in the previous
sentence is an example of a hypertext link.) Hypertext was the main concept that
led to the invention of the World Wide Web, which is, after all, nothing more (or
less) than an enormous amount of information content connected by an
enormous number of hypertext links.

Hyperlinks

A hyperlink is a word, phrase, or image that you can click on to jump to a new
document or a new section within the current document. Hyperlinks are found in
nearly all Web pages, allowing users to click their way from page to page. Text
hyperlinks are often blue and underlined, but don't have to be. When you move
the cursor over a hyperlink, whether it is text or an image, the arrow should
change to a small hand pointing at the link. When you click it, a new page or
place in the current page will open.

Hyperlinks, often referred to as just "links," are common in Web pages, but can
be found in other hypertext documents. These include certain encyclopedias,
glossaries, dictionaries, and other references that use hyperlinks. The links act
the same way as they do on the Web, allowing the user to jump from page to
page. Basically, hyperlinks allow people to browse information at hyperspeed.

Web Browser


http://searchsoa.techtarget.com/definition/link

Browser, short for web browser, is a software application used to enable
computers users to locate and access web pages. Browsers translates the basic
HTML (Hypertext Mark Up Language) code that allows us to see images, text
videos and listen to audios on websites, along with hyperlinks that let us travel to
different web pages. The browser gets in contact with the web server and
requests for information. The web server receives the information and displays it
on the computer.

There are different browsers for various things you do on the internet. There's a
text based browser. With a text based browser you are only allowed to see text.
Graphical material are not displayed. Hyperlinks are accessed by typing it in
through the keyboard. An example of a text based browser is LYNX. There's a
graphical browser and that allows the user to see all types of multimedia.

There are several types of browsers but the one thing they have in common is
that they carry out the same function; they transfer hypertext. Here are some
familiar common web browsers:

. Mozilla FireFox
. Netscape Navigator
. Microsoft Internet Explorer

Popular Web Browsing Softwares Google Chrome

It is a Web browser that is designed for Windows systems. It gives users a
minimal design that Google refers to as th 'sophisticated technology' which
makea the web faster, safer, and easier on Windows-based PCs. Google Chrome
includes searching from the address bar, thumbnail views of your favorite pages
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Mozilla Firefox



Mozilla Firefox is a free, open source, cross-platform, Web browser developed
by the Mozilla Corp. and hundreds of volunteers. Mozilla Corp. is responsible
for the browser, where volunteers and enthusiasts have created many of the plug-
ins available for the browser.

Microsoft Internet Browser Microsoft's Internet Explorer (IE) is currently
considered the dominant browser. IE version 7X offers tabbed browsing,
instant access to e-mail, integrated RSS support, better standards
compliance, a built-in phishing filter, advanced security (cross-domain script
barriers, International Domain Name Anti-Spoofing protection and so on),
and an option for deleting browsing history by removing user-identifiable
information.


http://www.webopedia.com/TERM/F/Firefox.html
http://www.webopedia.com/TERM/I/Internet_Explorer.html
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Netscape Navigator

The first commercial Web browser was Netscape. The latest version is available
for Windows XP, Windows 2000, Windows 98 SE and Windows ME. Netscape
Browser 8x is the next-generation release of Netscape's venerable and once
extremely popular Web browser. Version 8.0 is based on code from company
spin-off Mozilla, borrowing much of the functionality and format from the
increasingly popular Firefox browser.
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LYNX


http://www.webopedia.com/TERM/N/Netscape.html

Lynx is a highly configurable text-based web browser for use on cursor-
addressable character cell terminals. It is the oldest web browser currently in
general use and development.
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Ncsa Mosaic

it was the first to make a major splash. In November 1993, Mosaic v 1.0 broke
away from the small pack of existing browsers by including features—Ilike icons,
bookmarks, a more attractive interface, and pictures—that made the software
easy to use and appealing to "non-geeks." NCSA offered Mosaic free from its
website, and soon more than 5,000 copies were being downloaded each month;
the center was receiving hundreds of thousands of email inquiries a week,

and Internet traffic was dramatically rising.


http://en.wikipedia.org/wiki/Text-based_web_browser
http://en.wikipedia.org/wiki/Computer_terminal
ftp://ftp.ncsa.uiuc.edu/Mosaic/
http://www.ncsa.illinois.edu/Projects/mosaic/traffic.html
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Search Engine

A search engine is a web-based tool that enables users to locate information on
the World Wide Web. Popular examples of search engines are Google, Yahoo!,
and MSN Search. Search engines utilize automated software applications
(referred to as robots, bots, or spiders) that travel along the Web, following links
from page to page, site to site. The information gathered by the spiders is used to
create a searchable index of the Web.

Every search engine uses different complex mathematical formulas to generate
search results. The results for a specific query are then displayed on the SERP.
Search engine algorithms take the key elements of a web page, including the
page title, content and keyword density, and come up with a ranking for where to
place the results on the pages. Each search engine’s algorithm is unique, so a top
ranking on Yahoo! does not guarantee a prominent ranking on Google, and vice
versa. To make things more complicated, the algorithms used by search engines
are not only closely guarded secrets, they are also constantly undergoing
modification and revision. This means that the criteria to best optimize a site
with must be surmised through observation, as well as trial and error — and not
just once, but continuously.

Popular Search Engines

Google

Google is the undisputed king of web search. While it doesn't offer all the
shopping center features of Yahoo!, Google is fast, relevant, and the largest

single catalogue of Web pages available today. Google offers outstanding
features like photos, maps and many more.



Yahoo

it is a search engine, a news aggregator, a shopping center, an emailbox, a travel
directory, a horoscope and games center, and more. This 'web portal' breadth of
choice makes this a very helpful site for Internet beginners. Searching the Web
should also be about discovery and exploration, and Yahoo! delivers that in
wholesale quantities.

Alta Vista

Alta Vista was created by the research facility of Digital Electronics
Corporation(DEC) of USA. This search engine has a spider called scooter that
traverses the web and Usenet newsgroups. Indexing is based on the full text of a
document and the first few lines are used as an abstract. AltaVista search
supports full Boolean, phrase and case sensitive searches. The engine has two
modes of search types namely, simple and advanced search.

Hot Bot

HotBot is a web search engine currently owned by Lycos. This search engine is
most suitable for searching specific words or phrases. The HotBot search
contains a text box for the users to enter their query string, and a list box to
choose the appropriate rule, like all words, any words, or exact phrases. HotBot
is primarily used for fine-tunning your search.

Webcrawler

WebCrawler is a metasearch engine that blends the top search results
from Google Search and Yahoo! Search. WebCrawler also provides users the
option to search for images, audio, video, news, yellow pages and white pages.
WebCrawler is a registered trademark of InfoSpace, Inc. WebCrawler was
originally a separate search engine with its own database, and displayed
advertising results in separate areas of the page. More recently it has been
repositioned as a metasearch engine, providing a composite of separately
identified sponsored and non-sponsored search results from most of the popular
search engines.

Infoseek

It is a popular search engine with a robot that retrieves HTML and PDF
documents. It indexes full text and generates a short summary of each document.
InfoSeek allows searches in the web, Usenet groups, and web Frequently Asked
Questions (FAQ). This offers indexed site searches and divides the web into a
number of convenient baskets. Unlike Yahoo! InfoSeek aims to have catalogued
more websites than virtually any other search engine on the Internet.


http://en.wikipedia.org/wiki/Web_search_engine
http://en.wikipedia.org/wiki/Lycos
http://en.wikipedia.org/wiki/Metasearch_engine
http://en.wikipedia.org/wiki/Google_Search
http://en.wikipedia.org/wiki/Yahoo!_Search
http://en.wikipedia.org/wiki/InfoSpace

Lycos

It contains 66 million pages in its database. This search engine has a robot that
uses heuristics to navigate the web and build a searchable index. For each
document indexed, the robot keeps the outgoing links in a queue and selects a
URL from it. One heuristics for example may force the robot to select a URL
that points to a web server’s homepage. Users can submit URLs for indexing.

Accessing Web Browser

To access a web browser you need to do the following: 1. Install a web
browser software like Internet Explorer, Mozila Firefox on any other in your
machine.

2. Double click that particular icon. To open the browser 3.
Provide an address of a page which you want to see in the address
bar and press Enter.

Using Favorites Folder

Internet Explorer Favorites, also known as bookmarks, are simply a way of
saving a site that you like so you can find it later without going on the Web to
search for it. It's also a great system for organizing your search efforts in
manageable folders. If you don't have Internet Explorer and would like to try it
out, download Internet Explorer from Microsoft's Internet Explorer site.

How To Create A Favorite in Internet Explorer 1. Identify the sites
of your choice that you enjoy in your web search travels, and would like to save
for future reference.
2. Click on the "Favorites" icon in the Internet Explorer toolbar.
3. You'll see either a drop down menu or a left side screen
window pop up; depending on which Favorites icon or button you
selected. Select "Add", and click OK.
4. In my own experience, it's best to organize your Internet
Explorer Favorites as you add them by collecting them in folders.

Using Your Internet Explorer Favorites
The internet favourites can be used by clicking the favourites icon on the toolbar
and then select the site you would like to visit.

Organizing Your Internet Explorer Favorites In order to organize your
favourites follow the following steps 1. Click on the Favorites icon,
then on the Organize Favorites button.

2. Select the New Folder button. Pick an intuitive name, such as



"Favorite Blogs", and click Ok.

3. Now, select the Favorite you want to organize, and click on the
Move button.

4, Select the folder you want to move this Internet Explorer
Favorite to, and click Ok.

5. The best way to keep your Favorites useable is to move the
Favorite to a folder as soon as you want to add it.

Downloading Web Pages
In order to download a web page follow the following steps:
1. Open a desired website

2. Open a desired page to be downloaded from the website.
3. Click on the file option and select “Save Page As”
4.  Select the drive and folder the file is to be saved.
5. Click OK.
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Printing Web Pages

In order to print a desired webpage following steps are required :-
1. Open the website containing the page.
2. Open the desired webpage.
3. Click on the file button and select “print” option.



4. In case you want to preview the file click on the “print preview”
option else select the print option.

5. Clicking on the print option, the computer will open a print box
whereby we can select the printer, quantity and quality of the print.
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6. On selecting the desired quality, quantity and printer, click ok.

Understanding URL

Every Web page has a unique address called a URL (Uniform Resource Locator)
which identifies where it is located on the Web. For example, the URL for CSM
Library's home page is:http://www.smccd.eduaccountscsmlibrary/index.htm
The basic parts of a URL often provide "clues" to where a web page originates
and who might be responsible for the information at that page or site.

URLSs have three basic parts: the protocol, the server name and the resource
ID. Look again at CSM Library's URL below to see these three parts. The
protocol is shown at the beginning of the URL before the double slash (//); the



server name is between the double slash (//) and the first single slash (/); and the
resource id is everything after the first single slash (/).

http://www.smccd.eduaccountscsmlibrary/index.htm protocol | server name |
resource id Let's examine each part of this URL: First part: protocol (http://)
The protocol identifies the method (set of rules) by which the resource is
transmitted. All Web pages use HyperText Transfer Protocol (HTTP). Thus, all
web URL's (including CSM Library's) begin with http://.

Second part: server name (WWW.SIIICCd.Edu/ ) The server
name identifies the computer on which the resource is found. (Computers that
store and "serve up" Web pages are called remote servers.) This part of the URL
commonly identifies which company, agency or organization may be either
directly responsible for the information, or is simply providing the computer
space where the information is stored. Web server names often begin with the
letters www, but not always.

The server name always ends with a dot and a three-letter or two-letter extension
called the domain name. The domain is important because it usually identifies
the type of organization that created or sponsored the resource. Sometimes it
indicates the country where the server is located. The most common domain
names are: * .com which identifies company or commercial sites

* .org for non-profit organization sites

.edu for educational sites (most commonly four-year universities)

.gov for government sites

.net for Internet service providers or other types of networks If the domain
name is two letters, it identifies a country, e.g. .us for the United States, .uk for
the United Kingdom, .au for Australia, .mx for Mexico or .ca for Canada.

* ¥ %

The server name for our library's Web site is: www.smccd.edu. The server name
may also be the name of a Web site. (A Web site is a complete group of Web
pages that are organized as a comprehensive set.) Web sites can be either all of
the pages on one server (computer) or all of the pages under a specific
subdirectory on a server. For CSM Library, the server name (www.smccd.edu)
identifies the San Mateo County Community College District. The CSM Library
Web site consists of all of the  pages under  the
subdirectory: accountscsmlibrary.

Third part: resource ID (accountscsmlibrary/index.htm) The resource ID is
the name of the file for the page and any directories or subdirectories under
which it is stored on the specified computer. The resource ID for our library's
homepage is:accountscsmlibrary/index.htm. (A "homepage" is the opening or


http://www.smccd.edu/

main page for any web site that provides links to all of the other pages on the
site.) The part of the resource ID after the last slash (/) is the file name for the
specific page or other resource. The file name ends with a three or four letter
designation that specifies the file type (e.g., .htm or .html for a standard Web

page, .jpg or .gif for common graphic files.) IP Address and Domain
name What is an IP Address

The IP address takes the form of a dotted-quad number, such as 128.175.13.92.
No other computer/server on the same network or on the Internet can have the
same IP address at the same time.

When we use domain names to access a website or online service, we are using a
human readable shortcut which corresponds with the server's IP address. DNS
servers on the Internet automatically translate domain names into IP addresses
each time we use a domain name.

What is a Domain Name?

New computer users often confuse domain names with universal resource
locators, or URLs, and Internet Protocol, or IP, addresses. This confusion is
understandable. It is worth learning the differences between them because these
terms are ubiquitous. It is also helpful to be able to use terms correctly when
communicating to technicians or other people within a professional organization.

This naming convention is analogous to a physical address system. People find
web pages in a manner similar to the way that they use maps to find physical
locations. If the Internet is like a phone book, and a web page is like a physical
building, the URL would be the precise street address of that building. The IP
address would be like the car that travels to its destination. There are also other
useful metaphors for understanding this relationship.

Domain Names and URLs

The universal resource locator, or URL, is an entire set of directions, and it
contains extremely detailed information. The domain name is one of the pieces
inside of a URL. It is also the most easily recognized part of the entire address.
When computer users type a web address directly into the field at the top of their
browser window, it initiates a process of locating the page requested. To do so,
the instructions contained inside the URL, including the domain name, must
correctly point to that location. The IP address is a numerical code that makes
this possible.

Domain Names and IP Addresses An Internet Protocol, or IP, address is
different than a domain name. The IP address is an actual set of numerical



instructions. It communicates exact information about the address in a way that
is useful to the computer but makes no sense to humans. The domain name
functions as a link to the IP address. Links do not contain actual information, but
they do point to the place where the IP address information resides. It is
convenient to think of IP addresses as the actual code and the domain name as a
nickname for that code. A typical IP address looks like a string of numbers. It
could be 232.17.43.22, for example. However, humans cannot understand or use
that code. To summarize, the domain name is a part of the URL, which points to
the IP address.

How do Domains Work?

Domain names work because they provide computer users with a short name that
is easy to remember. Users enter web addresses into the URL field at the top of
their browser's page from left to right. The domain name itself is read from right
to left according to the naming hierarchy discussed below. This link provides
directions to the network, which ultimately results in a successful page load at
the client end of the transaction.

The common fictitious domain name, www.example.com, is comprised of three
essential parts:
J .com - This is the top-level domain.
o .example. - This is a sub-domain.
o .www. - This is a sub-domain prefix for the World Wide Web.
The original use of this prefix was partly accidental, and
pronunciation difficulties raised interest in creating viable
alternatives.

Many servers use a three-letter naming convention for top-level domains, and
they are separated from sub-domains by a dot. The significance of the top-level
domain is the most important for new users to grasp. It identifies the highest part
of the naming system used on the Internet. This naming system was originally
created to identify countries and organizations as well as categories.

The most common categories are easily recognized by new computer users, and
they include:

. .com
. .org
. .edu
. .net
. .mil

A significant expansion of the top-level domains occurred, and they now



include:

. .biz

. .museum
. .info

. .name

Country codes are also easily recognizable to new users because the
abbreviations are the same ones used for other purposes. The organization of the
domain name hierarchy and the ability to reserve them for only one purpose has
already undergone several modifications. Discussions and debates concerning
the availability and affordability of domain names can be expected to continue.

Sub-domains are organized to the left of the top-level domain, and this is the part
of the domain system that is most recognizable to humans. It is common to see
several levels of sub-domains, and some countries developed specific
conventions of organization to communicate information within their internal
naming systems.

Surfing The Web

Surfing the web, it is the most common line we hear from any person, whether
he is a student, professional or a home maker. Internet has penetrated into our
lives at a very fast pace. Today things like ordering food, reading newspapers,
getting reciepies all can be done on a click of a mouse. Internet has a vast
number of websites catering to various interest zones and classes therefore there
is something for everyone on the web.

Using E-governance Website e-Government is creating a comfortable,
transparent, and cheap interaction between government and its respective
citizens, government and business enterprises and relationship between
governments. There are four domains of e-government namely, governance,
information and communication technology(ICT), business process
reengineering( BPR)and e-citizen. The primary delivery models of e-
Government can be divided into: Government-to-Citizen or
Government-to-Consumer (G2C) Government-to-Business (G2B)

Government-to-Government (G2G) Government-to-
Employees (G2E) Within each of these interaction domains, four kinds of
activities take place: Uploading information over the Internet, e.g.:
regulatory services, general holidays, public hearing schedules, issue briefs,
notifications, etc.

Both-way communications between the government agencies



and the citizen, a business, or another government agency. In this model,
users can engage in dialogue with agencies and post problems, comments,
or requests to the agency.

conducting transactions, e.g.: lodging tax returns, bill payments
etc.

Model Questions with Answers

Q1. What are computer www?

Ans. is the leading information retrieval service of the Internet(the
worldwide computer network). The Web gives users access to a vast array
of documents that are connected to each other by means
of hypertext or hypermedia links—i.e., hyperlinks, electronic connections
that link related pieces of information in order to allow a user easy access to

them.
Q2. What is hypertext and hypertext link?
Ans. Hypertext is the organization of information units into

connected associations that a user can choose to make. An instance of such
an association is called a link or hypertext link.

Q3. What is a URL?

Ans. Every Web page has a unique address called a URL (Uniform
Resource Locator) which identifies where it is located on the Web.

Q4. Explain a web browser?

Ans. Browser, short for web browser, is a software application used

to enable computers users to locate and access web pages. Browsers
translates the basic HTML (Hypertext Mark Up Language) code that allows
us to see images, text videos and listen to audios on websites, along with
hyperlinks that let us travel to different web pages. The browser gets in
contact with the web server and requests for information.

Q5. What is an IP Address?

Ans. IP stands for Internet protocols. IP is a number or value that is used to
uniquely identify a computer on the Internet. It is a 32-bit value and this
number can be divided into four different sections separated by period.

Q6. What is a search engine?


http://www.britannica.com/EBchecked/topic/291494/Internet
http://www.britannica.com/EBchecked/topic/279726/hypertext
http://www.britannica.com/EBchecked/topic/279622/hyperlink
http://searchsoa.techtarget.com/definition/link

Ans. A search engine is a web-based tool that enables users to locate
information on the World Wide Web. Popular examples of search engines
are Google, Yahoo!, and MSN Search. Search engines utilize automated
software applications (referred to as robots, bots, or spiders) that travel
along the Web, following links from page to page, site to site.

Questions for self practice Q1. What do you understand by
WWW?

Q2. Explain atleast 3 web browsing softwares.

Q3. What do you mean by search engines?

Q4. How can we download an print web pages?

Q5. What is an e-governance website?

Q6. What is a domain name?

Q7. What is an IP Address?

Q8. What is a URL?

Multiple Choice Questions Q1. Which of the following is not a search
engine.

a) Yahoob) Googlec) Hotbotd) Rediffmail Q2.
Which of the following is not a web browser.

a) Mozilla firefox b) Google Chrome c) Yahoo d) Internet explorer.

Q3. Hypertext is the organization of __  into connected
associations.

a) Information Units b) Wires c) Internetd) None of the above.

Q4. Which of these is a characteristic of e-governance website.

a) G2C

b) G2G

c) G2E

d) All of the Above Q5. What are the types of websites a) Ststic

b) Dynamic c) None of the above d) Both a and b Answer : - 1-d; 2-c;
3-a; 4-d; 5-d True or False

1 Mozilla firefox is a search engine.

2. Google.com is a web browser.

3.  Every web page has a unique URL.

4. Data can be modified in static websites.

5.  Websites and web pages are the same.

6.  Data cannot be changed in dynamic websites.

7

E-governance sites helps in bringing government close to people.



8.  www stands for world wide web.

9.  Web pages cannot be downloaded.

10. 'Web pages can be printed and stored.

Answer : 1-false; 2-false; 3-true; 4-false; 5-false; 6-false; 7-true; 8-true; 9-
false; 10-true.



Chapter -7

Communications and Collaborations

As we have studied earlier the basics of internet and web browsing. The main
component that connects the world, through internet is facility of communication
or interation across the globe. Internet today facilitates use of emails, messaging
and other such facilities that helps us in connecting with the world. We can send
emails and messages to our friends and relatives anywhere in the world by using
the magical facility of an e-mail.

Objective of this chapter is to understand the basics of an email or an online
messaging service that is empowering our life today. Communication being the
basic most need of human beings is satisfied through this components.

Basics of an Email.

What is Electronic Mail or E-Mail.

Going by a basic definition we can say that an e-mail is a text messages that may
contain files, images, or other attachments sent through a network to a specified
individual or group of individuals. Just like in old days when we use to write
letter and telegrams to our relative, an email solves the same purpose in an
efficient and faster way. We can send email to any person on the network with a
valid email account with any host or website. An email is like any letter “From”
an email account “To” another email account with a specific “Subject” and
“Content”, with or without an “Attachment”. Here is an example of an email
from abc@yahoo.com to xyz@gmail.com



http://www.computerhope.com/jargon/t/text.htm
http://www.computerhope.com/jargon/f/file.htm
http://www.computerhope.com/jargon/i/image.htm
http://www.computerhope.com/jargon/a/attachme.htm
mailto:abc@yahoo.com
mailto:xyz@gmail.com

Components of An E-mail From: It refers to the e-mail address from which the
email is being sent, like in the case above it is sent by abc@yahoo.com.

To: It is the email address to whom the email is being sent, in the example above
the email is being sent to xyz@gmail.com.

.Bcc: Blind Carbon Copy; It is refered to as the addition receivers to whom a
copy of the mail is to be sent.

Subject: It is a one line summary of the content of the mail. Like “Submission of
Project”, Application for a Job”, etc.

Send : It is an instruction given to send the email to a desired address.

Email Addressing Using e-mails is not a rocket science its an easy step by step
procedure to communicate with the world.

1. First step is to open an email account. An email account is your
identity or address on the internet where people can send and receive
emails from you. In order to open an account one has to look for an
email hosting site like yahoo.com, gmail.com, rediffmail.com etc. On
filling a simple form on the website we can open an account on the
website.



In the above example, in order to open an account click on “New User? Register
Now?”, fill a simple form and create your online account.

2.

For sending an email, sign in into your email account by giving your
user name and password in the desired boxes and enter your email
address. On entering into your account you will see a screen shot as
shown below in the picture. You can choose to see the messages
received by you by clicking on “Inbox” and can send a new email by
clicking on “Compose”.
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The next technical step in emailing proceeds in your mailbox's SMTP
server. The SMTP server is a server application that is responsible for
sending messages over the SMTP protocol. It is a service generally
provided by your ISP. The message is sent from the mail address, the
SMTP server receives it over the network and reads the email address



set in the "To". It then asks for the MX record corresponding to the
recipient’s e-mail address.

4. Further, the DNS server responds with the MX DNS record of the
recipient’s e-mail address, and the SMTP server connects to it and
delivers the message to the opposite or reciever’s mail server.

5. Once the e-mail message is delivered to the mailbox on the
recipient’s mail server, the recipient can start his mail address
software application and receive the message by downloading it from
the server using the POP3 protocol.

Benefits of Email Following points highlight the benefits of emails:-

Ease of Communication

Email has reached a high level of popularity due largely to the convenience of it.
Messages move quickly and lots of information can be shared in the body of the
email or through attachments. Emails are easily archived and searched. Emails
offer the writer a chance to think through his thoughts and present a professional
level of communication. Businesses use email to solicit new clients, provide
customer service and keep employees in the loop on developments. Email's
versatility makes it an indispensable part of any modern small business.

Costs

Businesses can keep costs down by using low cost or free web email services.
Many documents that used to be sent through the mail at regular postage rates
can be sent by email. These savings add up significantly over time. Money is
also saved by the speed of email. Modifying a proposal and responding to
customer needs quickly might make the difference between a made sale and a
lost sale.

Marketing

Marketing is a major business use of email. A well-run email marketing
campaign is effective, inexpensive and builds good will with customers. Brick
and mortar businesses can easily send coupons or store updates to drive visitors.
Any business can start a regular e-newsletter with compelling content that
captures customers' attention and keeps the business at the front of their minds.
All of this comes without the printing and postage costs associated with physical
newsletters and mailings.

Ease of Access Emails can be accessed through laptops and other mobile
devices regardless of whether you are at the office, on the road, out in the field



or away for the weekend. Email allows employees and owners to efficiently
manage communications in ways that fit into their time and scheduling. It is a
key factor in having an effective mobile work force.

Collaboration Email can be sent to multiple people and groups for use as a
collaboration or training tool. This may come in the form of a survey or request
for feedback from customers. It can also be used for drafting business proposals
with partners and keeping employees in the loop on new procedures or projects.
Email allows the participants to work together at their own speed, rather than
under the pressure of a conference call or in-person meeting. It also means that a
good record of the work is maintained for future reference.

Step By Step Guide to Using Emails Step 1 : Opening an email Account
Email account can be opened with any web free email service like gmail.com,
yahoo.com, sify.com, rediffmail.com. Go to the website you desire to open an
account with for example sify .com.
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The click on the new user link given under “login to mail” and a form like the
one given below would appear.



Fill in your details, desired user name and password and get a free email account
for yourself.

Step 2 : Checking Inbox and Outbox

After opening an account one wishes to check his or her emails for checking the
messages being received or sent by them. For this one has to login into their
account by given valid username and password and following options would

appear.
OR\CE. "B w v

Here if we click on the “Inbox” we get a complete information about the mails
received and if we click on ourbox we get the complete details of the mails sent



by us.

Step 3: Creating and Sending a New Email
On entering our email account, we can see a plate named “compose”, when we
click on “compose” the following page opens

After opening this page, we type the email address of the receiver in “To”
column and one line jist of the mail in “Subject” column. Then we type the
content of the mail in the matter column and then we click on the “Send” button
to send the mail.

Step 4 Replying and Forwarding to an Emails.

After we have received an email from an account, we can send a reply to the
mail by clicking on the “Reply” option on the top of the page, after clicking on
reply it will open an compose page with receivers info in the “To” column
automatically.




If we want to forward that email to other friends or business associates, there is
an option of “Forward” available next to “Reply” by clicking on “Forward” we
can enter the email addresses of the people we want to forward the email to and
then click on the “Send” button.
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Step 5: Sorting and Searching Emails In our email account we get a facility of
sorting our emails as per our choice by catagorizing them. We can create a
personal folder whereby we can direct some of the emails from specific senders
directly into my personal account and in the same way we can create
professional accounts too.

Searching mails in your email account is a cake walk. There is a bar on the top
of the screen that gives you an option of searching a mail. We can type the email
address or subject words and click on the “Search Mail” option and it will
display all the mails received from that specific sender.
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Document Collaboration Document collaboration is becoming one of the fast
growing concepts across the globe. It is actually a simple creation of a pool of
written content by various people which is handled by an editor. It involves file
exchange through removable media or by email, through file server, information
portals or SharePoint and Wikis. With document collaboration, the contributors
of the content have the ability to add, edit and even remove the text in the system
if deemed appropriate. While, on the other hand, the writing process can be
changed from time to time as well depending on the goal of the system.

Instant Messaging and Collaboration It is a type of communications service
that enables you to create a kind of private chat room with another individual in
order to communicate inreal time over the Internet, analagous to a telephone
conversation but using text-based, not voice-based, communication. Typically,
the instant messaging system alerts you whenever somebody on your private list
is online. You can then initiate a chat session with that particular individual.
Some of the most important IM services today are provided by Google, Yahoo
Messenger, Rediffbol, Skype etc.

Netiquettes

The Rules of Netiquette are social norms that individuals choose to follow
facilitating effective communication on the internet. There are many accepted
internet etiquette rules users follow for many different reasons. The core rules of
netiquette are the most agreed upon netiquette rules. The golden Rule of
Netiquette is the foundation of Cyber Etiquette theory. As classes of websites
and formats for internet communication have expanded so have social
conventions, netietiquette. There are groups of internet rules for various websites
that are defined by site type, user, and cyber friends. Everyone could use a little
netiquette.

Model Questions and Answers

Q1. What is an e-mail?

Ans. E-mail is a text messages that may contain files, images, or
other attachments sent through a network to a specified individual or group
of individuals.

Q2. What are the components of an e-mail ?

Ans. Following are the components of an e-mail Subject Line:-
The subject line is the first thing seen when your email arrives in the inbox.


http://www.webopedia.com/TERM/C/chat_room.html
http://www.webopedia.com/TERM/R/real_time.html
http://www.webopedia.com/TERM/I/Internet.html
http://www.webopedia.com/TERM/T/text.html
http://www.computerhope.com/jargon/t/text.htm
http://www.computerhope.com/jargon/f/file.htm
http://www.computerhope.com/jargon/i/image.htm
http://www.computerhope.com/jargon/a/attachme.htm

It will also be the biggest factor in determining whether your email will be
opened. Subject lines should be clear and compelling.
"From" Field: This is equally important in determining whether

your email will be opened. The "From" field should be consistent and
credible.

“To” Field: This field describes the account name from which the
email has been sent. When ever a user creates a new email this field gets
automatically copied from the account name.

“Cc” Field: Cc field includes people who should know about the
message but don't need to act on it. They'll receive the same Body: Message
body contains the actual email message Q3. How can we open an email
account?

Ans. We can select a site of our choice to create an email id. On
selection of site we can register for an email i.d. by filling a small form and
entering a user id and password.

Q4. How to reply to a mail?

Ans. After we have received an email from an account, we can send
a reply to the mail by clicking on the “Reply” option on the top of the page,
after clicking on reply it will open an compose page with receivers info in
the “To” column automatically.

Questions for self practice.

Q1. How to open an email account?

Q2. What are the benefits of opening an email account?
Q3. What are the components of an email?

Q4. How can we reply to or forward an email?

Q5. How can we search for a mail in our inbox.?

Q6. What are netiquettes ?

Multiple Choice Questions Q1. BCC stands for .

a) Board of Cricket Control.
b) Board Circuit Collaboration c) Blind Carbon Copy d) None.

Q2. An e-mail can be a) Repliedb) Sendc) Forwardd) All
the above Q3. New in-coming mails are received in .
a) Outbox b) Spamc) Sentd) Inbox Q4. Which of the

following are example of Instant messanger.
a) Google talk b) Rediff bol c) Both of these d) None of these.
Answers :- 1-c; 2-d; 3-d; 4-c True or False



Not everyone can open an email account.

Instant messanger is an email service.

An email can be forwarded.

We can search for an email in our account.

We can sort emails as per our preference.

Data collaboration is not possible through email,

We can send attachments through mail.

Answers - a-false; b-false; c-true; d-true; e-true; f-false; g-true.

NoUuhkwh



Chapter 8

Making Small Presentations

A tool in the computer system named “Microsoft Powerpoint” enables us to
create presentations on our computer that can be used for presenting an idea or a
project in an effective audio-video format. Today students and corporates across
the globe are using powerpoint to create presentations in the form of slides to
present their data and information in an appealing format.

What is Microsoft Powerpoint PowerPoint is a presentation software program
that is part of the Microsoft Office package.

PowerPoint uses a graphical approach to presentations in the form of slide
shows that accompany the oral delivery of the topic. This program is widely
used in business and classrooms and is an effective tool when used for training
purposes. PowerPoint is one of the simplest computer programs to learn. It is
the number 1 program used worldwide for presentations. Anyone can create
stunning presentations that look like they were designed by a professional.

A Snapshot of MS Powerpoint
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Click to add title

Opening Microsoft Powerpoint In order to open Microsoft Powerpoint,
1. Click on the start button
2. From the Programs select “Microsft Office


http://presentationsoft.about.com/od/s/g/slide_show.htm
http://presentationsoft.about.com/od/powerpointinbusiness/
http://presentationsoft.about.com/od/classrooms/

3. Select Microsoft Power Point and double click the left button of the

mouse
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Opening A Power Point Presentation In order to open an already made power
point presentation we need to take the following steps:-

2. Left click on the file button on the top of the page.



&_J_Li 14 L Feronistont - oreet Fowmbe |z i

| el =
Erverd Prarwss, -
ha « i it o 4 ; Mo
| g Rl 5 -] S, Bpiare -
| A E s oy s il " 4 Swwd -
WALTEL wmar | | SUPET] Drang [N

T Fol faih by abdieh sk Ty

. I - = patiera e il
i, 7 W LNDAR R g

| Baskaue

ik
L T
= Surmendd Dby - BH
| Pypen = Py

=y pabasnes oo
- R B
[reep—
Pk | g

Click to add title

| B biid i | 2 byl e bin

ok to add notis

T e

4 & 3



4. On clicking on open a folder option will be seen on the screen.
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5. Select the desired file from the folder and double click on it to open.
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Saving a Power Point Presentation

Suppose you have made a power point presentation, the next step is to save that
presentation for future use. In order to save a presentation the following steps are
taken :-

1. Click on the file option on the top most bar of Microsoft power point.
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3. On clicking the “Save” option the power point will generate a folder
option, that helps you in saving the presentation in any desired
directory and folder.
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4. Select the desired directory and file and click on the save button, in
order to save the file.

‘he presentation

Creation of Presentation Now lets begin from the basics as to how to create a
presentation in a power point.

1. Open Microsoft power point as shown earlier in the chapter.

2. Starting a new file : Click on the file option on top of the page and
select “new” option.
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Selecting Templates and Designs : Go the the top bar of the power
point and click on “design”, it will give you a variety of page designs
and templates to choose from. Select a template that suits the theme
of your presentation.
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Blank Presentation :In case you want to create a blank presentation
then skip step no. 3. This will give you a blank presentation page.

Inserting and Editing Text : On selection of template, now its time to
enter text in your presentation. There are two textboxes provided on
the slide. One for the heading and another for the content. You can

simply type the heading of the slide in the heading textbook and basic
content in the content textbox.
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6. In order to edit the text just click on the textbox and make
amendments as required.

7. Inserting and Deleting Slides : In order to insert a slide, click on
new slide on the home bar of the power point page. This will give
you a similar new slide in same template and design
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8. In order to delete a slide, go to the slide thumbnail on the side of the
page and a rightclick on the slide you wish to delete, will generate
options like cut, copy, paste, delete slide etc. Select the delete slide

option by clicking on it.
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9. Inserting Word Table or Excelsheet: In order to enter a word table or
excelsheet, click on the insert option on the topmost bar next to home
bar. Clicking on insert opens up various options, select table option
given on the left side of the bar select the option of a row and column
table or an excel sheet to be inserted.
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Selecting the insertion of an excel sheet will give you a complete excel sheet on
your slide.



10. Adding Clipart or Picture to the Slide : In order to add a clipart or a
picture to the slide in order to make it more interesting, click on the

insert option as explained above and select the picture option on the
tab.
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On clicking the picture option, the power point will open a folder option,

whereby you can choose or select a picture from a specific file or directory that
your desire.
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Select the desired file and click “open”. On doing this the selected pivture will
be displayed on your slide. You can further adjust the size and location of the
picture on your slide.
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11. Inserting Other Objects in a power point : There are a variety of
things that can be inserted in a presentation like movies, sounds, text
tables, pictures, graphs etc. That helps a presenter to present his data
and information in the most interesting ways. You can add internet
links to the slide in order to shpow some facts and figures from the
internet.



Presentationl - Microsoft PowerPont

Drrign  Animstess  Ylide Shew  Bedew  View

D LBEP el @ird 3o 8
rl_i Filute  (hp | Fholo Sheges SmatRd (ke flppeierd Ason | Tesl Header Woeddd [t S8de  “ombo Ofjed Ho:r!hl.m

At ARgn= = Bor KFooler = BT Member
T

uttratmst i Mpdad gt

Ieevert Chip A ints the document,
ey drEaTg, mavees,
weundt, of stodk phetagraphy to

: _-.umlummmam. Click to add title

12. Resizing of Inserted Objects: The objects so inserted in a slide can
be further resized, scaled and positioned as per our requirements. For
example if we have to show some additional data in the slide in
different font and format, then we can resize the textboxes in order to
insert a third textbox as per desired size by expanding or reducing it
from the edge points.
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Viewing a Presentation Viewing a presentation is not just looking at the slides,
its the view of the presentation the way your audience will see it. Clicking on the
view option on the top bar of any version of power point will generate the
following option for you to select from.
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You can keep a normal view for the presentation, a notes style or a handout etc
views of the slides as per your wish.

Choosing a Setup for Presentation.

In order to work on the setup of a slide, select the slide show option on the top
barand click on the slide show setup. It gives you variety of choices from slide
timing, transition, speech, sizes etc. You can select the desired pattern for the
slide show and click “OK” on making the final desired changes.
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On deciding the setup for the slideshow we get the option of running a
presentation in the form of a slide show. Just by clicking a simple button we can
switch to slide show view.
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Adding Transition to the Slide Show In order to make slide show full of life
one can add different types of transitions. Transition means small styles or
animations that can be used in and switching of slides like fading, highlighting,
jumping etc. In order to add transition select the “Animation” option on the top,
it gives you an option to choose the kind of transition its timing, transfer sound
etc.
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Printing Slides and Handouts In order to use it for reference work one can take
a printout of the slides for preparation and future reference. In order to take a
print click on the file button on the left most side of the top bar. Select the print
option from the same. It gives you a choice to see a preview of the material.
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On clicking the print option, the print setup would be displayed on the screen.
You can select the printer, page setup and number of copies to be printed. On
selection press OK.
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Model Questions and Answer

Q1. What is Power Point Ans. PowerPoint is a
presentation software program that is part of the Microsoft Office package.
PowerPoint uses a graphical approach to presentations in the form of slide
shows that accompany the oral delivery of the topic.

Q2. How can you insert Picture in PowerPoint?

Ans. Picture can be inserted in PowerPoint in two ways:

From Clip Art From File Q3. Briefly Explain the Print
Option.

Ans. Print Option is available in the File Menu. From this option the

various Slides of the PowerPoint Presentation can be printed as well as
Handouts can also be printed.

Q4. How can we link internet files to power point?

Ans. In the insert option given on the top menu bar we can click on
the “link” option and then paste the link of web reference at a desired place.
Q5. How to save a presentation?

Ans. In order to save a presentation we need to click on the file

option and select “save”.

Questions for self practice Q1. How to open a presentation?
Q2. How can we enter and edit text in a presentation?

Q3. How can we insert an excelsheet in a presentation?

Q4. How can we insert or delete slides in a presentation?

Q5. How can we run a slide show in a presentation?

Multiple Choice Questions Q1. Pictures can be inserted into a presentation

through a) File b) Clipart c¢) Both of these d) None of these Q2.
Which of the following can be added to a slide.

a) Picture b) Sounds c) Excelsheet d) All the above Q3.

Which of the following commands to save a new file.

a) Saveb) Saveasc) Bothaandbd) Printpreview.

Q4. We can run a slide show by a) Adding transitions b) Show
setup ¢) Taking hand outs d) None of the above Answers : - 1-c; 2-d; 3-c;
4 —b True or False


http://presentationsoft.about.com/od/s/g/slide_show.htm

We can insert pictures to a presentation.

A presentation cannot be modified.

Movies cannot be added to presentation.
Internet links cannot be added to presentation.
We can see print preview of the slides.

We can change the templates of the slides.



